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What's New

1 What's New

New features in ODBC Driver for Firebird 4.0

¢ Added a graphical interface for configuring the driver on macOS and Linux

Added support for URL-style connection strings that use the inet4 and inet6 protocols

Improved compatibility with DBeaver

Improved compatibility with FileMaker

Improved compatibility with FileMaker Pro

Improved compatibility with SSIS in Visual Studio

Improved compatibility with Node.js

Improved compatibility with Tableau

Improved compatibility with Vectorworks

New features in ODBC Driver for Firebird 3.6

¢ Fixed connection timeout setting before opening connection

e Added support for Firebird 5

¢ Now passwords are stored in an encrypted form in the DSN record
¢ Added Read Only mode for connection

¢ Improved compatibility with ETL Informatica PowerCenter

¢ Improved compatibility with Altova Mapforce

¢ Improved compatibility with FileMaker Server for Linux and macOS

New features in ODBC Driver for Firebird 3.5

e Added support for setting SQL Dialect
¢ Improved compatibility with SSIS in Visual Studio

¢ Improved compatibility with 4D in macOS

New features in ODBC Driver for Firebird 3.4
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2 ODBC Driver for Firebird

e Added support for SQL_ATTR_MAX ROWS attribute

¢ Improved compatibility with Visual Basic in Visual Studio

New features in ODBC Driver for Firebird 3.3

¢ Added support for macOS 13 Ventura
¢ Improved compatibility with Tableau Prep Builder
¢ Improved compatibility with Crystal Reports

e Reduced number of metadata calls

New features in ODBC Driver for Firebird 3.2

e Added support for Windows 11
¢ Added support for Firebird 4

Improved compatibility with FICO Mosel

Improved compatibility with FileMaker

Improved compatibility with JMP on macOS

Improved support for an ODBC installer on Windows 2000

New features in ODBC Driver for Firebird 3.1

e MSlinstaller for deploying through GPO is added

New features in ODBC Driver for Firebird 3.0

e Compatibility with macOS Big Sur is improved

e Compatibility with Microsoft SQL Server Management Studio is improved
e Minor performance improvements

e Compatibility with Power Pivot is improved

e Compatibility with Visual Basic is improve

e Compatibility with RStudio is improved

e Support for connection pooling is improved

¢ Improved compatibility with sandboxed applications for macOS
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¢ Now ODBC driver activation does not require administrator privileges
e Now ODBC driver for macOS is distributed as a PKG package

e Now ODBC driver for Linux is distributed as DEB and RPM packages
e Possibility to force the ODBC 2.x behavior is added

New features in ODBC Driver for Firebird 2.4

¢ Possibility to return String Types as Ansi or Unicode is added
e Compatibility with MS Access is improved

e Compatibility with Omnis Studio is improved

e Compatibility with Power Pivot is improved

e Compatibility with DBeaver is improved

New features in ODBC Driver for Firebird 2.3

e Performance of batch operations is significantly improved

New features in ODBC Driver for Firebird 2.2

e Compatibility with SAS JMP is improved

e Compatibility with MS Power Query is improved

e OUTER JOIN macros in SQL queries are supported
e DateTime macros in SQL queries are supported

e Scalar function macros in SQL queries are supported

¢ The ForceUsingDefaultPort connection parameter is added

New features in ODBC Driver for Firebird 2.1

e Compatibility with MS Visual Studio

e Compatibility with MS FoxPro is improved
e Compatibility with Maplnfo is improved

e Compatibility with Libre Office is improved
e Compatibility with Qlik is improved
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4 ODBC Driver for Firebird

e Compatibility with Delphi & C++Builder is improved

e MS Access linked tables support is improved

New features in ODBC Driver for Firebird 2.0

e Linux is supported

e macOS is supported

e Support for stored procedures and functions is improved

e Backward compatibility of SQLExecDirect with ODBC 2.x is improved
e Compatibility with MS Excel is improved

e Compatibility with ODBC 2.x is improved

e Bug with Trial expiration in Microsoft SQL Server Management Studio is fixed

New features in ODBC Driver for Firebird 1.2

e Compatibility with Microsoft Visual Studio is improved

e Compatibility with Microsoft Office is improved

e Compatibility with Microsoft SQL Server Management Studio is improved
e Compatibility with Crystal Reports is improved

e Compatibility with ClikView is improved

e Compatibility with Microsoft Power Bl Desktop is improved

e Compatibility with Microsoft Visual FoxPro is improved

New features in ODBC Driver for Firebird 1.1

e Performance is improved

New features in ODBC Driver for Firebird 1.0

¢ First release of ODBC Driver for Firebird
e Windows 32-bit is supported
e Windows 64-bit is supported
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2 General Information

1. Overview

2. Features

3. Compatibility
4. Requirements

5. Licensing
6. Getting Support

2.1 Overview

Overview

Devart ODBC Diriver for Firebird is a high-performance connectivity solution with enterprise-
level features for accessing Firebird databases from ODBC-compliant reporting, analytics, Bl,
and ETL tools on both 32-bit and 64-bit Windows, macOS, and Linux. Our ODBC driver fully
supports standard ODBC API functions and data types and enables easy and secure access

to live Firebird data from anywhere.

v ODBC API
ODBC Data -
Types
Compatibility

ODBC Driver for Firebird supports Firebird 5.x, 4.x, 3.x, 2.x, and 1.x versions.
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6 ODBC Driver for Firebird

2.2 Features

v ODBC API
ODBC Data -
Types

ODBC Conformance

Our ODBC driver provides full support for common ODBC interface:
e ODBC Data Types support

e ODBC API Functions support

In addition, we provide support for Advanced Connection String parameters. Thus allowing
any desktop and web applications to connect to Firebird from various environments and
platforms, that support ODBC.

64

bit

32

bit

Development Platforms Variety

ODBC Driver for Firebird doesn't limit your choice of the development platform and
environment. The driver installations are available for various operational systems and
platforms. The current version supports Windows, macOS, Linux, both 32-bit and 64-bit. So
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you can develop both 32-bit and 64-bit cross-platform applications.

]
] I

—

Database Compatibility

ODBC Driver for Firebird supports Firebird 5.x/4.x/3.x/2.x/1.x versions

=l

High Performance

All our products are designed to help you write high-performance, lightweight data access

layers, therefore they use advanced data access algorithms and techniques of optimization.

| v

Support

Visit our Support page to get instant help from knowledgeable and experienced professionals,
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8 ODBC Driver for Firebird

a quick resolution of your problems, and nightly builds with hotfixes.

2.3 Compatibility

Firebird Compatibility

ODBC Driver for Firebird supports the following database servers:

Firebird Servers Support
Firebird 5.x V'
Firebird 4.x v
Firebird 3.x v
Firebird 2.x '
Firebird 1.x v

Note: Firebird 1.5 requires a UDF containing the RTRIM function for proper operation.

Supported Platforms

e Windows 32-bit and 64-bit (including Windows Terminal Server)
* macOS 32-bit and 64-bit
e Linux, 32-bit and 64-bit

Compatibility with Third-Party Tools

Application Development Tools

Adobe ColdFusion
Embarcadero Delphi & C++Builder

FileMaker

AR N SR

Lazarus
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General Information

Microsoft Visual FoxPro

Microsoft Visual Studio
Server Explorer and ADO.NET ODBC Provider

Omnis Studio

PHP

PowerBASIC

CICC S

Python

Database Management

Aqua Data Studio

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

CIC LS LS ]C K

SQL Server Reporting Services

Bl & Analytics Software

Alteryx

DBxtra

Dundas Bl

CILC S

IBM SPSS Statistics
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10 ODBC Driver for Firebird

MicroStrategy
Power Bl

Qlik Sense

QlikView

RStudio

SAP Crystal Reports
SAS JMP

Tableau

TARGIT

CIO IS SIS S 18K

TIBCO Spotffire

Office Software Suites

LibreOffice
Microsoft Access
Microsoft Excel

OpenOffice

AR N SRR NN

StarOffice

24 Requirements

The following requirements must be met for ODBC Driver for Firebird:

e The Firebird client library is available on your system.

¢ Only one version of ODBC Driver for Firebird is installed on your system.

25 Licensing
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ODBC Diriver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement”) is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop
computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.
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1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:
- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
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2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written
permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION
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Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems
will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
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other agreements, written, oral, expressed, or implied.

26 Getting Support

This document lists several ways you can find help with using ODBC Driver for Firebird
describes the Priority Support program.

Support Options

There are a number of resources for finding help on installing and using ODBC Driver for
Firebird:

¢ You can find out more about ODBC Driver for Firebird installation or licensing by consulting

Installation and License articles of this manual respectively.

¢ You can get community assistance and technical support on the Community Forum.

¢ You can get advanced technical assistance by ODBC Driver for Firebird developers

through the ODBC Diriver for Firebird Priority Support program.

Subscriptions

The ODBC Driver for Firebird Subscription program is an annual maintenance and support

service for ODBC Driver for Firebird users.

Users with a valid ODBC Driver for Firebird Subscription get the following benefits:
e Product support through the ODBC Driver for Firebird Priority Support program
e Access to new versions of ODBC Driver for Firebird when they are released

¢ Access to all ODBC Driver for Firebird updates and bug fixes

¢ Notifications about new product versions

Priority Support

ODBC Driver for Firebird Priority Support is an advanced product support service for getting
expedited individual assistance with ODBC Driver for Firebird-related questions from the
ODBC Driver for Firebird developers themselves. Priority Support is carried out over email
and has a two business day response policy. Priority Support is available for users with an
active ODBC Diriver for Firebird Subscription.
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16 ODBC Driver for Firebird

To get help through the ODBC Driver for Firebird Priority Support program, please send an
email to support@devart.com describing the problem you are having. Make sure to include

the following information in your message:

Your ODBC Driver for Firebird Registration number.

e Full ODBC Diriver for Firebird edition name and version number. You can find the version

number in DLL version information.
¢ Versions of the Firebird server and client you are using.
e A detailed problem description.

e If possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for Firebird.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com.

3 Using ODBC Driver

-_—

. Installation

. Product Activation

. Connecting to Firebird

. Connection String Parameters
. Sandboxed Apps on macOS

. Using with iODBC

. Enabling ODBC Tracing

. Supported Data Types
. Supported ODBC API Functions

© 00 N O 0o M~ w DN

3.1 Installation

ODBC Diriver for Firebird currently supports the following platforms: Windows, macOS, and
Linux, both 32-bit and 64-bit.

See how to install Devart ODBC Driver for Firebird:
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e \Windows

¢ Windows Silent

e macOS
e Linux DEB
e Linux RPM

3.1.1  Windows

Installation

1. Download and run the installer.

2. Follow the instructions in the wizard.

i5 setup - Devart ODBC Driver for Firebird — >
devo r‘t Welcome to the Devart ODBC Driver for
Firebird Setup Wizard
This will install Devart ODBC Driver for Firebird 3.0.2 on your
computer.

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.,

WARNIMG: This program is protected by copyright law and
international treaties.

ODBC Driver
for Firebird

3. If you already have the specified installation folder on the PC or another driver version is

installed, you will get a warning. Click Yes to overwrite the old files with the current
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installation, but it is recommended to completely uninstall the previous driver version first,
and then install the new one.

4. On the Select Components page, you can choose whether to install the 64-bit version of
the driver. Clear the checkbox if you do not need a 64-bit installation. There is also a

checkbox on this page that allows you to choose whether to install Help and Manual.

i setup - Devart ODBC Driver for Firebird — >
Select Components
Which components should be installed? devart

Select the components you want to install; dear the companents you do not want to
install. Clid Mext when you are ready to continue.

Full installation w

Devart ODBC Driver for Firebird 4.8 MB
. [] Driver for Win32 2,1ME
. [“] Driver for Wing4 2,8 MB
Help and Manual 8,7 MB

Current selection requires at least 15,3 MB of disk space.

5. On the License Information page, select when you want to activate the driver:
¢ Immediately after installation: Select Input Purchased or Trial activation key and
enter your key in the provided box, or click Load Activation Key and select the file
containing your key.

¢ Any other time: Select Activate product later.
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You need to activate the driver even for the trial version.
You can find your activation key in the registration email or your Customer Portal account.

To open the Customer Portal, click Get Purchased or Trial Activation Key.

EEE! Setup - Devart ODBC Driver —

License Information

Enter your Purchased or Trial Key to activate the product. Getit on the devart
Customer Portal or load it from a file.

© Input Purchased or Trial activation key

() Activate product later

U 1IwFHCODEMNGAEDF gbMzuck 12V GPY rkR Y IHE 7T

+th4+CROPhGPzZARMSEpY pPasaPTivaYeiQ 2bi TRig yHAI 7TTkhb /dKez W o4t oxSUZ]
bzayyAuSz2DgX FREMA M0 HhPIajyghTIEy Ez7DuelQ X tspppd SR IkS0UATL DO
end JOMzQGivDgFSx /dz09B0Inrhg 59KEgficpgwTZIWG /mmmTokwChkL JCxSSom3Ei9gh
BgWWchDug)/5lz8YkxSGAWKSGCHY 15gW Y +RZQFYgALILIOt 18NA =]

Get Purchased or Trial Activation Key... Load Activation Key ...

6. Click Next to complete the installation.
7. Click Finish to exit Setup.

8. After the installation is completed, you need to configure the driver.

See also:

¢ |nstallation on macOS

e |nstall Linux DEB package

¢ Install Linux RPM package
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3.1.2 Windows Silent

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCFirebird.exe /SILENT /ActivationkKey=ylc7nmgdu234TaszxcvONGurjfhxm9

DevartODBCFirebird.exe /VERYSILENT /ActivationkKey=ekhdh765mh09ukr237gfHRtril
Note: The installation is performed by entering a license key.
DevartODBCFirebird.exe /SILENT /ActivationFile=d:\1lic.key

DevartODBCFirebird.exe /VERYSILENT /ActivationFile=d:\1ic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation

process is performed without user interference.

3.1.3 macOS

Prerequisites

ODBC Diriver for Firebird works under the control of an ODBC driver manager. ODBC driver
manager is not distributed along with our driver and must be installed separately.

ODBC Diriver for Firebird is compatible with iODBC driver manager.

In case when using other ODBC driver managers, ODBC Driver for Firebird will be installed,
but it will require manual modification of the configuration files of these managers.

Installing ODBC Driver for Firebird

1. Go to Security & Privacy settings in the System Preferences.

2. Enable the App Store and identified developers option in the Allows apps downloaded
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from section.

@ < cEE Security & Privacy Q

m FileVault  Firewall  Privacy

A login password has been set for this user = Change Password...

Require password 5 minutes B after sleep or screen saver begins
Show a message when the screen is locked

Disable autematic login

Use your Apple Watch to unlock apps and your Mac

Allow apps downloaded from:

| App Store
° App Store and identified developers

~

Eﬁ Click the lock to prevent further changes. Advanced... ?

If the options in Allow apps downloaded from section are grayed out, click the lock icon and

enter your administrator password to proceed with the installation.

3. Download the PKG file from the Devart website.

4. Run the downloaded file, click Allow to proceed with the installation.
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® O = Install Devart ODBC Driver for FireBird ]

Welcome to the Devart ODBC Driver for FireBird Installer

This will install Devart ODBC Driver for FireBird 2.5.1 on your

@ Introduction computer.
Read Me WARNING: This program is protected by copyright law and international
} treaties
License

Registration
Destination Select
Installation Type
Installation

Summary

Continue

5. After reading the license agreement, click Agree.
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w Install Devart ODBC Driver =

To continue installing the software you must agree to the terms of
the software license agreement.

inY Click Agree to continue or click Disagree to cancel the installation and
Rei quit the Installer.
Lic
Rel . . ps
Read License Disagree Agree
De|
nstallation Type
INTRODUCTION
nstallation
- . This Devart end-user license agreement ("Agreement”) is a legal
summary agreement between you (either an individual person or a single legal

entity) and Devart, for the use of the ODBC Driver software application,
demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this
Agreement, the software program(s) and supporting documentation will
be referred to as the "Software”.

LICENSE

Print... Save... Go Back Continue

6. On the Registration page, specify your activation key using one of the following methods:

e Enter an activation key:

1. Select Input Purchased or Trial activation key.

2. Enter your activation key.
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[ ] w Install Devart ODBC Driver
Registration

License information

Enter your Purchased or Trial Key to activate the product. Get
Read Me it on the Customer Portal or load it from a file. Alternatively,
use the existing key.

Introduction

License

. . Input Purchased or Trial activation ke
® Registration O Inp y
Use existing activation key or activate product later

LleGzgzn3kJ3RPGYaSNmMTIFTebsNiHX4j5h+vdOjxEE2letLKA+p/
KrdNx3m7 1vaktsotElzQUg/
Cez19+YeFRpdx5LO2+MhIQ8R2IWsDYKThoZ X OGAUKaEG4s5TIN
J1EijViQ5gZ0g1BkNgXaLytOgsAZgLIHysizWU+vAZOgvar09iGVHa
N544EI7/wAVQOIEVEQqRRsKnZenDRNIJ36gjo2ShPUGZI7DwWMS

Get Purchased or Trial Activation Key...

Load Activation Key...

Improvement Program®

*Help us improve our products and fix issues faster by sharing a limited set of
anonymous data, including functionality usage statistics, diagnostic infermation, and
performance data.

Go Back Continue

¢ Load an activation key file:
1. Click Load Activation Key.

2. Navigate to the location of the activation file.

3. Click Open.
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o0 '« Install Devart ODBC Driver
Registration

License information

Enter your Purchased or Trial Key to activate the product. Get
it on the Customer Portal or load it from a file. Alternatively,
use the existing key.

Introduction
Read Me
License

© Input Purchased or Trial activation key

® Registration
Use existing activation key or activate product later

Get Purchased or Trial Activation Key...

Load Activation Key... ¥

Improvement Program®*

25

Favorites

T Recents

H
H
H

i
<
|

v [ Downloads

A Applications Name

[ Documents B activation.key

1) Downloads

iCloud
> iCloud Drive

Locations
& BigSure
& Machintosh...

& pub &
i Network

Tags

8 a

Kind

w
I

300 bytes

Cancel

Keynote Document

You need to activate the driver even for the trial version.

You can find your activation key in the registration email or your Customer Portal account. To

open the Customer Portal, click Get Purchased or Trial Activation Key.

If you're reinstalling the driver or don't want to activate the driver right now, select Use

existing activation key or activate product later.

7. To complete the installation click Continue, then click Install.
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& & Install Devart ODBC Driver =

The installation was completed successfully.

Introduction
Read Me
License
Registration

Destination Select The installation was successful.

Installation Type The software was installed.

Installation

Summary

| Close

To activate the driver, perform the steps described in the Product Activation article.

See also:

¢ |nstallation on Windows

¢ Install Linux DEB package

e |nstall Linux RPM package

314 LinuxDEB

Prerequisites
ODBC Driver for Firebird works under the control of an ODBC driver manager. ODBC driver

manager is not distributed along with our driver and must be installed separately.

ODBC Diriver for Firebird is compatible with unixODBC driver manager. Depending on your
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Linux distribution, you can install the unixODBC driver manager using one of the following
commands:

e For Ubuntu 23 and later versions:

sudo apt-get install libodbcinst2 libodbc2 odbcinst unixodbc

e For other distributions, including Ubuntu 22 and earlier versions:

sudo apt-get install odbcinstldebian2 libodbcl odbcinst unixodbc

If you are using other ODBC driver managers, ODBC Driver for Firebird will be installed, but it
will require manual modification of the configuration files of these managers.

Installation

Let's consider how to install Devart ODBC Driver on Linux from a DEB package, for example,
on Ubuntu. There are two ways to install the driver: manually using the GUI or via the
command line.

GUI installation
1. Download the DEB package of the required bitness from the Devart website.

2. Navigate to the folder with the downloaded package ("Downloads" by default) and double-
click it.

3. In the opened dialog, click Install.
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Ubuntu Software

vartodbcfirebird

devartodbcfirebird
New level of functionality and performance in data access via ODBC

Install

Devart ODBC Driver for Firebird provides a high-performance and Feature-rich connectivity solution For
ODBC-based applications to access Firebird databases from Windows, macOS, Linux, both 32-bit and 64-bit.
Full support For standard ODBC API functions and data types implemented in our driver makes interaction of
your database applications with Firebird Fast, easy and extremely handy.

Website

Details

Version 3.0.1
Source Unknown
Size 3,4MB

[ non-Free Ml 3rd party |

This software comes from a 3rd party and may contain non-free components.

If the installation is successfully completed, the Install button changes to Remove.

To activate the driver, perform the steps described in the Product Activation article.

You need to activate the driver even for the trial version.

Command-line installation
1. Download the DEB package from the Devart website.

By default, the required package will be downloaded into the ~/Downloads folder (or the
selected one).

2. Run the 'Terminal' program.

3. Navigate to the folder with the downloaded package (if you downloaded the package to a

folder other than ~/Downloads, specify the path to that folder as the cd command

parameter):
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cd ~/Downloads/

test@ubuntu:~5% cd ~/Downloads/
test@ubuntu:~/Downloadss I

4. To install the devartodbcfirebird _i386.deb on a 32-bit system, use the following command:

sudo dpkg -i devartodbcfirebird_i386.deb

test@ubuntu:~5 cd ~/Downloads/
test@ubuntu:~/Downloads$ sudo dpkg -1 devartodbcfirebird i386.deb |

5. To install the devartodbcfirebird_amd64.deb on a 64-bit system, use the following

command:

sudo dpkg -i devartodbcfirebird_amd64.deb

test@ubuntu:~% cd ~/Downloads/
test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcfirebird amdé4.deb

The driver is installed successfully.

test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcfirebird i386.deb
Selecting previously unselected package devartodbcfirebird.

(Reading database ... 238638 files and directories currently installed.)
Preparing to unpack devartodbcfirebird i386.deb ...

Unpacking devartodbcfirebird (3.8.1) ...
Setting up devartodbcfirebird (3.8.1)
test@ubuntu:~/Downloads5 I

To activate the driver, perform the steps described in the Product Activation article.

You need to activate the driver even for the trial version.

See also:
¢ Install Linux RPM package

¢ |nstallation on Windows
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¢ |nstallation on macOS

3.1.5 Linux RPM

Prerequisites
ODBC Driver for Firebird works under the control of an ODBC driver manager. ODBC driver

manager is not distributed along with our driver and must be installed separately.
ODBC Diriver for Firebird is compatible with unixODBC driver manager.

If you are using other ODBC driver managers, ODBC Driver for Firebird will be installed, but it
will require manual modification of the configuration files of these managers.

Installation

Let's consider how to install Devart ODBC Driver on Linux from an RPM package, for
example, on CentOS. To install the driver, download the .rpm package and install it via the
command line. See the detailed description of these steps below.

1. Download the RPM package from the Devart website.
By default, the required package will be downloaded to the ~/Downloads folder (or the
selected one).

2. Run the 'Konsole' program.

3. Navigate to the folder with the downloaded RPM package (if you downloaded the package
to a folder other than ~/Downloads, you need to specify the path to that folder as the cd

command parameter):

cd ~/Downloads/

4. To install the devart-odbc-firebird.i386.rpm on a 32-bit system, use the following command:

sudo rpm -ivh devart-odbc-firebird.i386.rpm
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[test@localhost ~]% sudo rpm -ivh devart-odbc-firebird.i386. rpm

To install the devart-odbc-firebird.x86_64.rpm on a 64-bit system, use the following

command:

sudo rpm -ivh devart-odbc-firebird.x86_64.rpm

~t-odbc-firebird.x86_64.rpm

rpm -ivh devart-odbc-firebird.x86 64.rpm

FA R [ 100

S [ 100%

To activate the driver, perform the steps described in the Product Activation article.

You need to activate the driver even for the trial version.

See also:
¢ Install Linux DEB package

¢ |nstallation on Windows

¢ |nstallation on macOS

3.2 Remote Installation

One of the key advantages of Group Policy is the ability to deploy software remotely using MSI
files. This section explains how to use Group Policy to remotely install the ODBC Driver for
Firebird on client computers.

The information is organized into the following sections:
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3.21

e Creating the MST File Using Orca

e Remote Deployment and Activation

e Upgrading Driver Version and License Key

Package Transformation

Creating the MST File Using Orca

To customize the installation of the ODBC Driver for Firebird, you first need to edit the
Windows Installer Package (MSI) by creating an MST file. This will allow for customized
installation of an original Windows Installer (MSI) Package.

An MST file, or Windows Installer Setup Transform file, contains program configuration
settings. In our case, the MST file for the ODBC Driver for Firebird will include the correct
license information. This MST file is used together with the original MSI package in the Group
Policy software distribution system.

There are many tools available for customizing MSl file settings, so you can choose the one
that best suits your needs. In this example, we'll be using Orca, which is available as part of
the Windows SDK Components for Windows Installer Developers. For more information
about Orca, visit the official Microsoft website.

To start the process of MST file generation using the Orca editor, follow the steps below:

1. Launch the Orca application, then open the required MSl file by selecting Open in the File

menu or click the Open icon on the toolbar below.
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€% Untitled - Orca — [m} P4
File Edit Tables Transform Tools View Help
0O = e
Tables

&% Open *

Lok in: |, soft v| @ T m-
* MName ° Date modified Type Size
5/ DevartODBCSalesforce  8/16/2024410PM  Windows Installer Package 80,5¢

Quick access

Desktop
m
Libraries

Ga

This PC
< >

i File name: |DevartODECSaIesforce v| | Open
Network

Files of type: Installer Database Files (*.msi, “msm, *pcp, “msp)} w Cancel
[]open as read-only

Tables: 0 Mo table is selected. Mo column is selected.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Driver for Firebird.

2. As aresult, the Tables menu on the left side of the main application window will display the
properties of the selected MSl file.

3. Next, navigate Transform -> New Transform.

€% DevartODBCSalesforce.msi - Orca
File Edit Tables Transform Tools View Help

O = Mew Transform
Tables Apply Transform...

AdminExecuteSeq View Patch...

AdminUlSequence

AdvtExecuteSeque Generate Transform...

AppSearch Close Transform...

Binary

CheckBox Transform Properties...

Component

Condition

Control

ControlCondition
ControlEvent
CreateFolder
CustomAction
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4. To proceed, select Property from the Tables menu, then double-click any empty row on

the right side of the application window.

=

File Edit Tables Transform Tools View Help

0 E-f

Tables Property Value

AdminExecuteSequence UpgradeCode (WEFJ7AZF6-2864-4ADF-A3EB-EEDFT620E45?}

AdminUlSequence
AdvtExecuteSequence
AppSearch

Binary

CheckBox
Component
Condition

Control
CantrolCondition
ControlEvent
CreateFolder
CustomAction
Dialog

Directory
EventhMapping
Feature
FeatureComponents
File

lcon
InstallExecuteSequence
InstallUlSequence
LaunchCendition
ListBox

Media
MsiFileHash
RadicButton
Reglocator
Registry
RemoveFile
Shortcut

Signature
TextStyle

UlText

Upgrade
_Validation

WIXULLCUSTOMEXITDIALOGOPTIONALCHECKBOX

WixUIRMOption
WIXULINSTALLDIR
IsTrial

ALLUSERS
ProducthName
ARPPRODUCTICON
ARPHELPLINK
ARPURLINFOABOUT

UseRM
INSTALLLOCATION
Trial

2
Devart ODBC Driver for Salesforce
App.ico

WELCOME_TEXT
EXISTS
ISVALIDLICENSE
ARPNOMODIFY
MSIUSEREALADMINDETECT|
Manufacturer
ProductCode
ProductLanguage
ProductVersion
DefaultUIFont
Wixl_Mode

ErrorDialeg

Infolcan

CRLF

TAB

SPACE

AdminProperties
SecureCustomProperties

https://forums.devart.com/viewforum.phpif=35
httne: /A devart mindhe/
Add Row 3 }C Driver for Salesforce 3.4.1 on your computer. Click Mext to continue or Cancel to exit.
Name  Value
?Pmperty ACTIVATIONKEY
Value h32y

Column
Value - Localizable String[0], Required

AWwgealGiBkJOBWTv SARGMED/uquyﬂE'rBTHCxFA#l

WERFOUND; OLDESTFOUND; SELFFOUND;WIX_UPGRADE_DETECTED

Cancel

In the Add Row dialog that opens, make the following settings and press OK to apply the

changes:

¢ Property - enter ACTIVATIONKEY with capital letters only.

e Value - enter the valid OEM license key for the ODBC Driver for Firebird.

As shown in the following screen, a new property, ACTIVATIONKEY, has been added, with

the license key displayed in the value column next to it.

5. Once the configuration changes have been made, select Transform -> Generate

Transform.
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2% DevartODB(CSalesforce.msi (transformed by Untitled) - Orca

File Edit Tables
0O & t
Tables
AdminExecuteSeq
AdminliSequence
AdvtExecuteSeque
AppSearch
Binary
CheckBox
Compenent
Condition
Control
CentrelCondition
ControlEvent
CreateFolder
CustomAction
Dialog

Directory
EventMapping
Feature
FeatureComponents
File

lcen
InstallExecuteSequence
InstallUlSequence
LaunchCendition
ListBox

Media

MziFileHash

Property
RadioButton
Reglocator
Registry
RemeoveFile
Shortcut
Signature

Transform | Tools

View Help

New Transform

Apply Transform...

View Patch...

"DIALOGOPTIONALCHECKBOX

Generate Transform...

Close Transform

Transform Properties..
[

ARPPRODUCTICON

ARPHELPLINK

WELCOME_TEXT
EXISTS
ISVALIDLICENSE
ARPMOMODIFY

Manufacturer
PreductCede
Preductlanguage
PreductVersion
DefaultUIFont
WixUI_Mode
ErrorDialog
Infolcon

CRLF

TAB

SPACE
AdminProperties

ARPURLINFOABOUT

SecureCustomProperties

MSIUSEREALADMINDETECTION

Value
{BE17A2F6-2B64-4ADF-A3EB-82DF1620B457}
1
UseRM
INSTALLLOCATION
Trial

2

Devart ODBC Driver for Salesforce

App.ico
https://forums.devart.com/viewforum.php?=53
https://www.devart.com/odbc/

The Setup Wizard will install Devart ODBC Driver for Salesfarce 3.4.1 on your computer. Click Next to continue or Cancel to exit.
NO

0

1

1

Devart
{AEF4136F-3503-4328-9FD4-2883780CC432}
1033

341

WixlJl_Fent_Nermal

Mendo

ErrorDig

info

WIXUI_CUSTOMEXITDIALOGOPTIONALTEXT
ARPNOMODIFY;NETFRAMEWORKA3; NEWERFOUND; OLDESTFOUND: SELFFOUND; WIX_UPGRADE_DETECTED

[ ACTVATIONKEY

+1C/nddkR Hi2P It TPLYdEQt It

6. In the Save Transform As dialog that appears, enter a suitable name for the new MST file

and click Save to apply your settings.

=4

File Edit Tables Transform Teols View Help

D& M FE=mE M

Tables Property Value

AdminExecuteSequence UpgradeCode {BE17A2F6-2B64-4ADF-A3ER-82DF1620B457}

AdminlISequence
AdvtExecuteSequence
AppSearch

Binary

CheckBox
Compenent
Condition

Contrel
ControlCondition
ControlEvent
CreateFolder
CustomAction

Dialog

Directory
EventMapping
Feature
FeatureComponents
File

lcen
InstallExecuteSequence
InstallUISequence
LaunchCenditicn
ListBox

Media

MsiFileHash

Property
RadioButton
Reqlocator
Reqistry
RemoveFile

WixUIRMOption
WIKUI_INSTALLDIR
IsTrial

ALLUSERS
ProductName
ARPPRODUCTICON
ARPHELPLINK
ARPURLINFOABOUT
WELCOME_TEXT
EXISTS
ISVALIDLICENSE
ARPNOMODIFY

Manufacturer
ProductCode
Productlanquage
ProductVersion
DefaultUIFent
WixU_Mode
ErrorDialog
Infolcon

CRLF

TAB

SPACE
AdminProperties

WIXUI_CUSTOMEXITDIALOGO)|

IMSIUSEREALADMINDETECTIO)

SecureCustomProperties

2% Save Transform As x
Savein: [ soft - @& i E-
* Name - Date modified  Type 5i
No items match your search.
Quick access
- puter, Click Next to continue or Cancel to exit.
Desktop
[ o}
Libraries
This PC
&5 5
Network
File name: » | ‘ Save
Save as type: Windows Installer Transform (* mst) - Cancel | D;WIX_UPGRADE_DETECTED

7. If successful, the encryption message DevartODBCSalesforce.msi (transformed by

DevartODBCSalesforce.mst) - Orca will be displayed at the top of the Orca application

window.
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ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce.mst) - Orca

File Edit Tables Transform Tools View Help

b= A - 2|
Tables ~ | Property Value
AdminExecuteSequence WixUIRMOption UszeRM
AdminUlSequence WIXULINSTALLDIR INSTALLLOCATION
AdvtExecuteSequence I=Trial Trial
AppSearch ALLUSERS 2
Binary ProductMName Devart ODBC Driver for Salesforce
CheckBox ARPPRODUCTICON App.ico
Component ARPHELPLIMEK https://forums.devart.com/viewforum.phpif=53
Condition ARPURLINFOABOUT https://www.devart.com/odbc/
Control WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.4.1 on you
ControlCondition EXISTS MO
ControlEvent ISVALIDLICENSE 0
CreateFolder ARPMNOMODIFY 1
CustomAction MSIUSEREALADMINDETECTION 1
Dialog Manufacturer Devart
Directory ProductCode {AEF4136F-3503-4528-9FD4-2885780CC432}
EventMapping Productlanguage 1033
Feature ProductVersion 341
FeatureComponents DefaultUIFont WixUl_Font_Mormal
File Wixl_Mode Mondo
lcon ErrorDialog ErrorDlg
InstallExecuteSequence Infolcon info
InstallUlSequence CRLF
LaunchCondition TAE
ListBox SPACE
Media AdminProperties WIXUILCUSTOMEXITDIALOGOPTIOMNALTEXT
MsiFileHash SecureCustormProperties ARPNOMODIFY: NETFRAMEWORKAS;NEWERFOUMND; OLDESTFOUMD; SELFF
[ ACTIVATIONKEY uw7iCODENGAEOFabNziuflXuBv3wbzR2Et] CEDMCTIh+TVwTelHrTrcRLE
RadicButton
Realocator bl B >
Tables: 37 Property - 29 rows Mo celumn is selected.

In case of a positive outcome, the newly created MST file will be located in the folder you

specified, alongside the MSl file.

3.2.2

Deployment and Activation

Installing and Activating Software Remotely

Group Policy automated-program installation is specifically designed for deploying Windows

Installer packages (MSl files). Therefore, when deploying the ODBC Driver for Firebird using

Group Policy, be sure to use the corresponding MSl file for the ODBC Driver for Firebird.

Prerequisites: Locating the MSI Installation File

Prior to making configuration settings in the Group Policy, you'll need to create a distribution

folder:

1. Create a shared network folder on the publishing server.

2. Set the appropriate sharing permissions on this folder to allow read access to the driver

installation package for all domain users.
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3. Download the ODBC Driver for Firebird MSl file, and place it in the network folder.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Diriver for Firebird.

Further in this section, you'll find more detailed information on how to deploy and activate the
ODBC Diriver for Firebird on remote client computers using Group Policy.

Server-Side Actions
1. Open the Group Policy Management desktop application.

2. In the Group Policy Management window, navigate to the desired forest node, then
expand the appropriate option under the Domains node. For this example, we'll select
devart-test.test. Right-click the Domains node, and from the context menu, select Create

a GPO in this domain, and Link it here.

2L Group Policy Management = O X
3 File Action View Window Help - F
Lol AN:a) e (N=RNENEN 7 Ho:

', Group Policy Management devart-test.test
v —i\ F?rest: de.\rart-test.test Status  Linked Group Policy Objects  Group Policy Inheritance  Delegation

v |53 Domains
~ pldevaitietior o T S : “ve Directory and 5Y'SVOL replication for this domain as it relates to Group Policy.
s Default Do Create a GPO in this domain, and Link it here...
w Devart ODE Link an Existing GPO...
5 Wind L .
_”.r " D_WS Bleck Inheritance
2| Domain Cc
s Group _PDH' Group Policy Modeling Wizard... 3t test is the baseline domain controller for this domain. Change
¥ WM Filterg MNew Organizational Unit
=] Starter GPC
— a in exists for this domain.
[ Sites Search...
58 Group Policy Mod Change Domain Controller... w to gather infrastructure status from all of the domain cortrollers in this domain.
4 Group Policy Resu R
=l emove
Active Directory Users and Computers...
View ¥
MNew Window from Here
Refresh
Properties Detect Now
Help

Create a GPO in this domain a

3. You can now create a New Group Policy Object. In the New GPO dialog enter a name for
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the new object and click OK. The new GPO will then appear within the Group Policy

Management container.

For example, let's create a GPO named after the ODBC driver name.

Mew GPO

Mame:

| Devart ODBC Driver|

Source Starter GPO:
{none)

Cancel

Keep in mind that each ODBC Driver for Firebird Windows installation package corresponds

to one Group Policy Object (GPO), which is important for managing future software

upgrades. To install multiple drivers using Group Policy, you need to create a separate GPO

for each driver you want to deploy.

4. Right-click the new object and select Edit from the context menu.

5L Group Policy Management - O >
5L File Action View Window Help - &
&9 | nF X6 HE
', Group Policy Management Devart ODBC Driver
M —é‘ F?r;st: de.\rart-test.test Scope Detalls Settings Delegation
w (54 Domains
w 3 devart-test.test Links
s Default Domain Policy Display finks in this location: devart test test w
s Devart ODBC Driver The follnwing sites damainsand Ol s are linked to this GPO:
5| Windows Update Server Edit... h — P o
== : orce inl able Eil
Bl Domain Controllers .
v [ 5 Group Policy Objects ) (R No Yes devarttest test
=[ Default Domain Centrollers Pe N Enakie
=[ Default Domain Policy Save Report... B
. i
= Devart ODBC Driver View

=] Windows Update Server
¥ WMI Filters
5] Starter GPOs
[ Sites
st8 Group Policy Modeling
4 Group Policy Results

Open the GPO editor

Mew Window from Here

Delete
Rename

Refresh

Help

sly to the following groups, users, and computers:

wve

Properties

WMI Filtering

This GPO is linked to the following WMI fiter:
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5. In the left pane of the Group Policy Management Editor, navigate to Computer
Configuration --> Policies --> Software Settings --> Software installation. Your
current deployment package will appear in the right pane. Right-click Software

installation, then select New --> Package.

_§£ Group Policy Management — O
_%é F||e A i AL A al Llal
E[ Group Policy Management Editor — O *
|
File Action View Help
= Grou —
vARe® aFEEGE HE
¥ '5| 5] Devart ODBC Driver Name Version Deployment st.. Source
™ ~ i Computer Configuration
w || Policies
~ [ Software Settings
Software installation
| Windows Settings New » Package... h
| Administrative Templat )
= View >
| Preferences
v i, User Configuration Paste
5 _ Policies Refresh
i | Preferences .
i Export List...
Properties
H
< elp
IL
Adds a package.
WMI Filtering

This GPO is linked to the following WMI filter:

6. In the Group Policy Management Editor dialog that opens, select the desired MSI

installation file and click Open.
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& Group Policy Management - O *
.%5 File fmtimm  lfim  Ufiecles Llale - &
$$| Il Group Policy Management Editor — O e
|, Grou| [ Open x
v —ﬁ ;_ I« test-ad-del » soft v O Search soft 2
W
“ Organize = MNew folder ==+ [ 0
oft\DevartODBC "
| Pictures 2 Mame Date modified Type
i evart 19/ : Nindows Installer Pac
| videos DevartODBC 8/19/2024 5:59 PM  Windows Installer Pack
. Local Disk (C:)
¥ Metwork 2
] v < >
Jd File name: |De\.rartODBC v| Windows Installer packages (*.r ~
£ >

WMI Filtering
This GPO ig linked to the following WM fitter:

7. In the Deploy Software dialog, select Advanced to specify the software deployment

method. The Advanced deployment method allows you to make necessary modifications

to the MSl file, such as creating the MST file in Orca.

Deploy Software

Select deployment method:

Published

Select this option to configure the Published or Assigned options,
and to apply modffications to a package.

Cancel

8. In the Properties dialog of the installation package that opens, go to the Modifications tab

and select Add. Browse for the corresponding MST file, select it, and click Open to apply
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the settings.

\&l Group Policy Management
3 File  Action View Window Help
e 7@ X4

=L Group Policy Management Pevart OUBL UnverFroperties ‘ “
Forest: devart-test.test
M —ﬁ oresh crvartestis General Deployment Upgrades Categories Modfications  Security
~ |55 Domains
w jj devart-test.test Modffications or transforme allow you to customize the package and are [
4 Default Domain Policy applied to the package in the order shown in the following list - O
2/ Devart ODBC Driver Modifications:
sz Windows Update Server ‘\est-ad-dc 1'soft\DevartODBC mst Move Up
|2 Demain Controllers |
(5 Group Palicy Objects Move Down ion  Denlovment st..  Source
[ WMI Filters = Open X
L] Starter GPOs
[ Sites P L « test-ad-decl » soft v O Search soft -l
57 Group Policy Modeling
[% Group Policy Results Organize + Mew folder == » [ 0
&=/ Pictures ~ Name Date modified  Type
Removel [ Videos [ DevartODBC.mst 8/16/2024 40...  MST File
—_— 2 Local Disk (C
Important! Do not press OK uf & Local Disk (C)
comectly. For more informatiol
then click What's this? = Network
v < >
FIENELEM D evart ODBC.mst v| ‘Windows Installer transform pa
9. If configured correctly, the Group Policy Management Editor window should look as
follows:
=/ Group Policy Management Editor - O >

File Action View Help
s nEE = HE
=/ Devart ODBC Driver ~ || Mame - Version Deploymen... Source
v M Computer Configuration
w || Policies
w [ ] Software Settings
Software instal
[ ] Windows Settings
| Administrative Ter
| Preferences

w 4% User Configuration b4
£ >

evart ODBC Driver 34 Assigned Wtest-ad-dcl\soft\Devart ODBC.msi

Client-Side Actions

For the ODBC Driver for Firebird to be successfully installed on remote client machines, all
domain users must restart their computers after logging in for the first time.

In case of successful deployment, the ODBC driver will be installed on the client's computer.
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To verify, open the ODBC Data Source Administrator on the client's machine and add the

deployed ODBC driver.

Create Mew Data Source

Select a driver for which you want to set up a data source.

MName Wersion

Devart ODBC Driver 3.04.01.00
SQL Server 10.00.15041.01
£

Col

De
Mir

< Back Cancel

All information on the deployed driver is accessible upon clicking the About tab.
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Devart ODEC Driver Cenfiguration X

General Advanced Settings Security Settings  Tracng License About

Devart ODBC Driver
Desktop License

Version:

devart

5.3.0
Web:

www, devart, comfodbc

E-mail:

support@devart.com

ODBC Driver

© 2015-2025 Devart. All right reserved,

Test Connection . Cancel

Similarly, the valid license key will be automatically activated after the successful installation
of the ODBC Drriver for Firebird.
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Devart ODEC Driver Cenfiguration X
General Advanced Settings  Security Settings  Tradng License  About

License Information

Company:
Devart

User name:
QDBC Account

License number;
299E-2C8-001

Licensed for:
1 Desktop

Subscription for free updates expires on 12/31/2029

Get Purchased or Trial Activation Key...
Input Activation Key...

Deactivate Product

Test Connection . Ok Cancel

See Also
e Creating the MST File Using Orca

¢ Activating on Windows - ODBC Drriver for Firebird

¢ License Information - ODBC Driver for Firebird

3.23 Software Upgrade

Automatic Software Update Using Group Policy

If the ODBC Driver for Firebird was initially deployed through Group Policy, it can be easily
updated to a newer version. Follow the steps below to update both the ODBC Driver for
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Firebird and the license to newer versions on all remote computers in the domain.

1. Download the ODBC Driver for Firebird installation MSI file of a newer version and place it

in the shared network folder.

2. Create a new MST file with a new license key using Orca.

If your license is still valid, there's no need to create a new MST file. Use the current MST file

instead.
ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce_new_key.mst) - Orca — [m] *
Eile Edit Tables Transform Tools View Help
= #
Tables ~ | Property WYalue
AppSearch UpgradeCode {8E17A2F6-2B64-4ADF- ASEB-82DF 16208457}
Binary WIXUI_CUSTOMEXITDIALOGOPTIOMALCHECKBOX 1
CheckBox WixUIRMOption UseRM
Component WIXUI_INSTALLDIR INSTALLLOCATION
Cendition IsTrial Trial
Control ALLUSERS 2
ControlCondition ProductMame Devart ODBC Driver for Salesforce
ControlEvent ARPPRODUCTICON App.ico
CreateFolder ARPHELPLINK https://forums.devart.com/viewforum.php?f=33
CustomAction ARPURLINFOABOUT https://www.devart.com/odbc/
Dialeg WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.3.0 on your computer, Click Next to continue
Directory EXISTS MO
EventMapping ISVALIDLICEMSE ]
Feature ARPNOMODIFY 1
FeatureComponents MSIUSEREALADMIMDETECTION 1
File Manufacturer Devart
lcon ProductCode {73ABASBS-E56E-4828-BE3B-B6FDABSECS39)
InstallExecuteSequence ProductLanguage 1033
InstallUlSequence ProductVersion 3.5.0
LaunchCondition DefaultUIFont Wixl|_Font_Normal
ListBox WixUl_Mode Mondo
Media ErrorDialog ErrorDig
MsiFileHash Infolcon info
| Property CRLF
RadicButton TAB
Reglocator SPACE
Reqistry AdminProperties WIXUI_CUSTOMEXITDIALOGOPTIOMALTEXT
RemoveFile SecureCustomProperties ARPMOMODIFY:NETFRAMEWORK45;NEWERFOUMD; OLDESTFOUND; SELFFOUND;WIX_UPGRADE_DETECTED
Shortcut ACTIVATIONKEY wiCODBNGAEOFabNziuflXu RIEt1CADMCTIh+TVw/el HrTrc1RLFrwmdCSawbSwaRMXara3 kDofi2d
Signature
TextStyle
UlText
Upgrade
_Validation v | < >
Tahles: 37 Pronerty - 79 rows. Mo column is selected

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Diriver for Firebird.

3. Follow the same workflow as outlined in Step 4 to Step 7 of the ODBC Driver for Firebird

Remote Deployment and Activation section.

4. In the Properties dialog that appears after selecting the Advanced deployment method,

go to the Upgrades tab and click Add.
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2) Properties ? it

It
F
Q- General Deployment Upgrades Categores Modifications  Security
i Packages that this package will upgrade: Add Upgrade Package
5

Choose a package from
(®) Cumrent Group Policy Object (GPO)
() A specific GPO:

Browse...

Package to upgrade

Devart ODBC Driver for Salesforce (2)

Add... Remove

Required upgrade for existing packages

Packages in the cument GPO that will upgrade this package:

() Uninstall the existing package, then install the upgrade package
(®) Package can upgrade over the existing package

ok Conce

Make sure to select the following check boxes while adding the package:

e Current Group Policy Object
e Package can upgrade over the existing package

5. Browse for the corresponding GPO object and click OK to apply the settings.

BCSalesforce....
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Browse for a Group Policy Object

Domains/OUs  Sites Al

< |
|_'::>
g
[
1

Look in: |5 devart test test

All Group Paolicy Objects stored in this domain:

Mame

|=[ Defautt Domain Controllers Policy
\=[ Defautt Domain Policy

E Devart ODBC Driver for Salesforce
=] Windows Update Server

6. Now the Upgrades tab of the Properties dialog will list a new package with a newer

version.
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Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modffications  Security

Packages that this package will upgrade:

Upgrade Devart ODBC Driver for Salesforce

Upgrade Devart QDBC Driver for Salesforce (2]

Add... Bemove

Required upgrade for existing packages

Packages in the cumert GPO that will upgrade this package:

Corcs

7. Go to the Modifications tab in the same properties dialog, click Add and browse to the
MST file.

We have already created a new MST file with a new license key in Step 2.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using ODBC Driver 49

Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modifications  Security

Maodffications or transforms allow you to customize the package and are
applied to the package in the order shown in the following list:

Modffications:

West-ad-de 1soft \DevatQDBC Salesforce_new keym Mave Up

Move Down

oo

Impaortart! Do not press OK until all transforms are added and ordered
comectly. For mare information, right-click on the Modfications list box, and
then click What's this?

Corcs

8. In case of a positive outcome both the old and new versions of the driver package will be

displayed in the Group Policy Management Editor.

= Group Policy Management Editor
File Action View Help

as Hm EQ HE

- Devart ODBC Driver for Salesfor|| Name Version Deploymentst.  Source
v i Computer Configuration Devart ODBC Driver for Salesforce 34 Assigned \\test-ad-dc\soft\DevartODBCSal...
v [ Polides Devart ODBC Driver for Salesforce (2) 35 Assigned \\test-ad-dc1\soft\DevartODBCSal..

v [ Software Settings
Software installat

| Windows Settings
| Administrative Templ

| Preferences

- n".; User Configuration
_ Policies
_ Preferences

Once the GPO configuration on the server is complete, the ODBC Driver for Firebird will
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automatically update to the latest version each time a client computer restarts.

Client-Side Actions

To update the ODBC Driver for Firebird to a newer version on remote client machines, all
domain users must restart their computers after their first login.

If successful, both the driver and the license key will be automatically updated to the new
version on remote computers. For detailed instructions on how to view the technical details of
the ODBC Driver for Firebird after upgrading, refer to Client-Side Actions.

See Also
e Creating the MST File Using Orca

¢ Remote Deployment and Activation - ODBC Driver for Microsoft Access

e Activating on Windows - ODBC Diriver for Firebird

e License Information - ODBC Driver for Firebird

3.3 Product Activation

See how to activate Devart ODBC Driver for Firebird:

e Obtaining Activation Key

e Activation on Windows

e Activation on macOS

e Activation on Linux

e Where to see the license information

3.3.1  Obtaining Activation Key

Follow these steps to obtain your product activation key:

¢ Fromthe Customer Portal:

1. Open the Customer Portal and sign in.

2. On the Product licenses page, select the driver.

3. Click Copy to clipboard to copy the activation key.
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3.3.2

Product licenses

;J ODBC Driver

Activation key:

VAWDR4A4AXOIgBa==

Copy to clipboard

Assign this license to:

¢ From the registration email:

LicenselD Owner Assigned

> 375E-422F-001 email@example.com NOT ASSIGNED

Export license details

Type

Single

nkLId7irC4nhZdUFN/6gbWxHYJhCHIyILz/195Nu90z Tp5cTIff 2pFg+LImLxlyGXPThgvA+D4jRhwwWBYXBEVZn
azsgkJiZwohsuG3+/Biy/MMHUNZhtrpM8lc3119Y wocKuaB4ANeGE7IC78ddalFfPumci+D280t829+16tnCSPwqV7
B8Q3GS1ZIoWYwWFIiJIiQvaN1cSYnep6553/3InHiF CaaKdfE46WdbqgQrimLNfHU+ZwvFDR3bTFKcEvgGgHITTCh

1. Locate the registration email you received from Devart after installing the driver. This

email contains a Purchased or Trial activation key.

2. Copy the activation key.

See also:

e Activation on Windows

e Activation on macOS

e Activation on Linux

Activation on Windows

Driver Activation After Installation

To activate your installed driver, perform the following steps.

You need to activate the driver even for the trial version.

1. Open the ODBC Data Source Administrator.
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2. On the System DSN tab, click Add.

'E- QDBC Data Source Administrator (84-bit)

User DSN  System DSN  File DSN  Drivers Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QDBC Driver for Azure_x32 32bit Devart ODBC Driver for SAL 5

QDBC Driver for BigClommerce_x32 32-bit Devart ODBC Driver for BigCor Remaove
QDBC Driver for Dynamics_32 32bit Devart ODBC Driver for Dynamr

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebirc Configure. ..

QDBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MailChimp_x32 32bit Devart ODBC Driver for MailCh
QDBC Driver for Mongo DB Ed-bit Devart ODBC Driver for Monge
QDBC Driver for MongoDB_x32 32bit Devart ODBC Driver for Monge

QDBC Driver for MySQL 32bit 32bit Devart ODBC Driver for MySQI ¥
< >

An QDBC System data source stores information abowt how to connect to the indicated data provider.
1| A System data source is visible to all users of this computer, including NT services.

Cancel Apply Help

3. Inthe Create New Data Source dialog, select the installed driver, then click Finish.
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Create Mew Data Source >

Select a driver for which you want to set up a data source.

MName 1A

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

< >

< Back Cancel

4. In the configuration dialog, navigate to the License tab, and click Input Activation Key.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

54 ODBC Driver for Firebird

Devart ODEC Driver Cenfiguration X

General Advanced Settings  Security Settings  Tradng License  About

License Information

Mot registered

You may register ODEC Driver at
https: /fwww, devart, comfodbcf<driver=fordering. htmil

Get Purchased or Trial Activation Key...

Input Activation Key...

Test Connection . Ok Cancel

5. Here, you can activate the driver using one of the following methods:
e Enter an activation key: Paste your activation key into the corresponding box.
¢ Load an activation file: Click Load Key and select the file that contains the activation
key.
You can find your activation key in the registration email or your Customer Portal account.

To open the Customer Portal, click Get Purchased or Trial Activation Key.
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Devart ODBC Driver Configuration x
General Advanced Settings Security Settings  Tracing License  About

License Information

Mot registered

You may register ODBC Driver at
https: ffwww.devart, comfodbc/<driver=fordering. html

-

Input Activation Key >

Activation Key

U 1w FCODENGAEDFgbMzjuck IzVxGPY kR Y IHE TTv

+th4-+CROPh&PZARMS3pY pPasaPTivaeiQ 2bi 7Fig Y yHAI FITkhb /dkazwWog 4t oxSUZibzgVyAuSz 2DgX FREM
AJjhZj0+hPlajyghTIEy Ez TDxe0Q X tspppd SR Ik30uAIb fIdOWenAIQMNzQGivDgFSx fdz09B 0 Inrhg 59KEg fic
powTZIWa mmmTokyCkLICx5SomSEi9ghS8gWchDug/Slz8 kxS G AWKSGCHY 15gWYr
+/RZOF{¥gALILIOt 13NA |

Load Key... Cancel

Get Purchased or Trial Activation Key...

Input Activation Key... .

Deactivate Product

Test Connection - (8.4 Cancel

6. Click OK.

3.3.3 Activation on macOS

Driver Activation After Installation

If you didn't activate Devart ODBC Driver for Firebird during installation, you can activate it
later using one of two methods:

¢ Online via a console application (for Perpetual and Subscription licenses).

¢ Offline with an activation file (only for Perpetual licenses).

You need to activate the driver even for the trial version.
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Activate Online via a Console Application

To activate the driver over the internet using a console application, follow these steps (this
method works for both Perpetual and Subscription licenses):

1. In the console, go to the folder where the driver was installed. The default installation path
iS /Library/ODBC/Devart/Firebird.
2. Optional: To open the Customer Portal in your browser and locate your activation key, run

the following command:

./firebirdodbcactivator -g

Alternatively, you can find your activation key in the registration email.

3. Run the activation command with superuser privilege, providing either the driver activation

key or the path of the file with the key:

¢ To activate using the activation key:

sudo ./firebirdodbcactivator -a <activation_key>

Replace <activation_key> with the driver activation key.

¢ To activate using a file:

sudo ./firebirdodbcactivator -a <file_path>

Replace <file_path> with the full path of the file containing the driver activation key.

When the process is complete, the driver is activated, and the License Summary is displayed
in the console.

Activate Offline With an Activation File

To activate the driver offline (only for Perpetual licenses), follow these steps:

1. Go to the folder where the driver was installed. The default installation path is /Library/

ODBC/Devart/Firebird.

2. In that folder, create a file with the activation.key name.
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3.34

3. Copy the activation key from the registration email or your Customer Portal account and

paste it into the created file.

4. Save the file.

The driver gets activated.

See also:

e Activation on Windows

e Activation on Linux

Activation on Linux

Driver Activation After Installation

If you didn't activate Devart ODBC Driver for Firebird during installation, you can activate it
later using one of two methods:

¢ Online via a console application (for Perpetual and Subscription licenses).

¢ Offline with an activation file (only for Perpetual licenses).

You need to activate the driver even for the trial version.

Activate Online via a Console Application

To activate the driver over the internet using a console application, follow these steps (this
method works for both Perpetual and Subscription licenses):

1. In the console, go to the folder where the driver was installed. The default installation path
is:
e For the DEB package: /usr/share/devart/odbcfirebird
¢ For the RPM package: /usr/local/devart/odbcfirebird

2. Optional: To open the Customer Portal in your browser and locate your activation key, run

the following command:
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./firebirdodbcactivator -g

Alternatively, you can find your activation key in the registration email.

3. Run the activation command with superuser privilege, providing either the driver activation

key or the path of the file with the key:
¢ To activate using the activation key:

sudo ./firebirdodbcactivator -a <activation_key>

Replace <activation_key> with the driver activation key.

¢ To activate using a file:

sudo ./firebirdodbcactivator -a <file_path>

Replace <file_path> with the full path of the file containing the driver activation key.

When the process is complete, the driver is activated, and the License Summary is displayed
in the console.

Activate Offline With an Activation File

To activate the driver offline (only for Perpetual licenses), follow these steps:

1. Go to the folder where the driver was installed. The default installation path is:
e For the DEB package: /usr/share/devart/odbcfirebird
e For the RPM package: /usr/local/devart/odbcfirebird

2. In that folder, create a file with the activation.key name.

3. Copy the activation key from the registration email or your Customer Portal account and

paste it into the created file.

4. Save the file.

The driver gets activated.

See also:

e Activation on Windows
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e Activation on macOS

3.3.5 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. Open the ODBC Data Source Administrator.

2. On the System DSN tab, click Add.

'-;- QODBC Data Source Administrator (84-bit)

User DSN  System DSN  File DSN  Drivers Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QODBC Driver for Azure_x32 32bit Devart ODBC Driver for SAL 5

QODBC Driver for BigCommerce_x32 32-bit Devart ODBC Driver for BigCor Remove
QODBC Driver for Dynamics_32 32bit Devart ODBC Driver for Dynarmr

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebirc Configure...

QODBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MailChimp_x32 32bit Devart ODBC Driver for MailCh
QODBC Driver for Mongo DB Ed-bit Devart ODBC Driver for Monge
QODBC Driver for MongoDB_x32 32bit Devart ODBC Driver for Monge

QDBC Driver for MySGL 32bit 32-bit Devart ODBC Driver for MySQI ¥
< >

An QDBC System data source stores information abowt how to connect to the indicated data provider.
1| A System data source is visible to all users of this computer, including NT services.

Cancel Apply Help

3. Select the driver, then click Finish.
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Create Mew Data Source >

Select a driver for which you want to set up a data source.

MName 1A

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

< >

< Back Cancel

4. In the configuration dialogue, navigate to the License tab to view the license details.
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3.41

Devart ODEC Driver Cenfiguration X

General Advanced Settings  Security Settings  Tradng License  About

License Information

Company:
Devart

User name:
QDBC Account

License number;
299E-2C8-001

Licensed for:
1 Desktop

Subscription for free updates expires on 12/31/2029

Get Purchased or Trial Activation Key...
Input Activation Key...

Deactivate Product

Test Connection . Ok Cancel

Connecting to Firebird

See how to connect to the ODBC Driver for Firebird:

¢ \Windows DSN Configuration

e macOS DSN Configuration

¢ Linux DSN Configuration

Windows

Windows DSN Configuration

61
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After installing the driver, create a DSN for Firebird in the ODBC Data Source Administrator.
1. Open the ODBC Data Source Administrator.

* Type oDBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open
ODBC Data Sources from Control Panel > Administrative Tools. Note that before
Windows 8, the icon was named Data Sources (ODBC).

e Alternatively, you can run c:\Windows\SysWoW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe t0 create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for Firebird and click Finish. The driver setup dialog will
open.

5. Enter the connection information in the appropriate fields.
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Devart ODBC Driver for Firebird Configuration o

General  Advanced Settings  License  About

Data Source Mame |Devart QDBC Firebird |

Description |Dri'~rer for Firebird |
Server 127.0.0.1 | Port |3050 |
Database |D:1|,ib‘|,EMP'TT.FDE! |

User ID |5YSDBA |

Password | sssssnnes | Save Password

Client Library |C:\Prugram Files\FirEbird‘n,FirEbird_Z_E‘n,bin‘n,FndiE| -
Protocol TCP v

Test Connection - Cancel

6. You can test the connectivity by clicking Test Connection.

7. Click OK to save the DSN.

See Also

Connection Options

342 Mac
macOS DSN Configuration

After the driver is installed, DSN with the name DEVART_FIREBIRD is created. You can use
it to test a connection with FIREBIRD server. For this, perform the following steps:

1. Run the iODBC utility of the required bitness. Find the DEVART_FIREBIRD section and
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click the Configure button:

[ ] iODBC Data Source Administrator (64-Bit Edition)

- User DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Name Description Driver Add
DEVART_ASE - Devart ODBC Driver for ASE

DEVART_FIREBIRD Devart ODBC Driver for Firebird Remove
DEVART_INTERBASE - Devart ODBC Driver for InterBase Configure
DEVART_MONGODB - Devart ODBC Driver for MongoDB ————
DEVART _MYSQL - Devart ODBC Driver for MySQL
DEVART_ORACLE - Devart ODBC Driver for Oracle
DEVART_POSTGRESQL - Devart ODBC Driver for PostgreSC Test
DEVART_REDSHIFT - Devart ODBC Driver for Amazon R
DEVART_SQLAZURE - Devart ODBC Driver for SQL Azure
DEVART_SQLITE - Devart ODBC Driver for SQLite

DEVART SQLSERVER - Devart ODBC Driver for SAL Serve

System Data Source Names create systems-wide ODBC Data Mames that resolve to Data
E Source connection information.

Cancel
v

2. In the appeared dialog, specify the required connection settings and click OK.
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e O Setup of DEVART_FIREBIRD

Data Source Name (DSN)  DEVART_FIREBIRD
Comment

Keyword Value

Data Source 127.0.01

Database JUsers/test/Documents/fdb.fdb
Port 3080

User D svsdba

Password FRETEES

+ —

3. Now click the Test button to establish a test connection to your data source.

65
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@ iODBC Data Source Administrator (64-Bit Edition)

User DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Name Description Driver Add
DEVART_ASE - Devart ODBC Driver for ASE

DEVART_FIREBIRD Devart ODBC Driver for Firebird Remova
DEVART_INTERBASE - Devart ODBC Driver for InterBase Configure
DEVART_MONGODB - Devart ODBC Driver for MongoDB| ———
DEVART_MYSQL - Devart ODBC Driver for MySQL

DEVART_ORACLE - Devart ODBC Driver for Oracle
DEVART_POSTGRESQL - Devart ODBC Driver for PostgreSC
DEVART_REDSHIFT - Devart ODBC Driver for Amazon R
DEVART_SQLAZURE - Devart ODBC Driver for SQL Azure
DEVART_SQLITE - Devart ODBC Driver for SQLite

DEVART SQLSERVER Devart ODBC Driver for SOL Serve

_____ System Data Source Names create systems-wide ODBC Data Mames that resolve to Data
E Source connection information.

Using Client Library with SIP enabled

When SIP is enabled on your machine, put the client library file in either of these directories
and specify the path to the client library in the Client Library connection parameter.

¢ /Applications
e /Library

e /usr/local

If you place the client library in either of the following directories when SIP is enabled, the
driver will not be able to access the library due to protection for these parts of the system by
SIP.

e /System

e Jusr
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e /bin
e /sbin
e /var

¢ Apps that are pre-installed with OS X

If you would like to disable SIP on your system, follow the instructions. Read more about
System Integrity Protection in macOS documentation.

See Also

Connection Options

3.4.3 Linux

Linux DSN Configuration

After the linux (DEB or RPM) driver is installed, a DSN with the name DEVART_FIREBIRD is
created. You can use it to test the connection with the FIREBIRD server. For this, perform the

following steps:
1. Open the odbc.ini file located in the /etc folder. Find the DEVART_FIREBIRD section and

specify the required connection settings:

User ID=<your Firebird user name>

Password=<your Firebird password>

Server=<your Firebird server address>

Port=<your Firebird port>

Database=<your Firebird database name>

Client Library=<path to the used Firebird client library>

2. Run the UnixODBC Test Command utility and test a connection using the following

command:

isql -v DEVART_FIREBIRD
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test@ubuntu:~% isql -v DEVART_FIREBIRD

Connected!

sgl-statement
help [tablename]

See Also

Connection Options

3.5 Connection String Parameters

Firebird ODBC Connection String Parameters

The following table lists the connection string parameters for Firebird.

Paramet

Description
er
ClientLibra L . . .

The full path to the Firebird client library - for example, D: \fbclient.d11
ry

Database | The full path to the database to connect to.
Password | The password of the Firebird user.

Port The port number for the connection. The default port number is 3050.

The network protocol for the connection to the Firebird server. Possible

Protocol  |Values:
TCP
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Uses TCP/IP to connect to the server.
NetBEUI

Uses NetBEUI named pipe for connection
SPX

Uses the SPX protocol for connection
Server Serves to supply the server name for login.

User ID Used to supply a unique User ID for login.

Advanced Settings

AllowNullst
ringsInteta Some parameters don't accept null values when retrieving metadata. if a
data

third-party tool passes a null value to such a parameter, the driver returns
EmptyString : L :

an error. These options ensure compatibility with such third-party tools.
sAsNullInMe
tadata

Used to set the character set that the driver uses to read and write
Charset

character data.

Connection The option for passing additional connection parameters separated by
Options comma to the Firebird server.
If the default port (3050) is used in the DSN settings, it will be cut out of the
connection string for compatibility with certain versions of Firebird. That

F Usi
. said, other versions of Firebird won't work correctly if the default port is not

Default

. explicitly specified in the connection string. The Force Using Default Port
option forces the driver to keep the default port in the connection string.
The default value is False.
Sets the behavior corresponding to the ODBC specification version
expected by a third-party tool. The behavior of the ODBC driver can be

ODBC changed by calling the SQLSetEnvAttr function to set the

Behavior | SQL_ATTR_ODBC_VERSION environment attribute. Some third-party tools

expect the driver to exhibit ODBC 2.x behavior, but forget to call
SQLSetEnvAttr with the needed version, or pass an incorrect value. In this
case, the behavior can be explicitly set in the connection string.
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ReadOnly

0

The default value. ODBC behavior is determined by a third-party tool.
2

ODBC 2.x behavior is explicitly set.
3

ODBC 3.xbehavior is explicitly set.

Used to prevent data from being modified, if set to True. The default value

is False.

RegionalNum Enables the use of local regional settings when converting numbers to

berSettingsshings_

RegionalDat

eTimeSettin

gs
Role

String
Types

Enables the use of local regional settings when converting dates and

times to strings.

Used to specify the role that has been granted to the user.

Sets the string value types returned by the driver as Default, ANSI, or
Unicode.
Default

The driver defines the string types.

Ansi

All string types are returned as SQL_CHAR, SQL_VARCHAR, and
SQL_LONGVARCHAR.

Unicode

All string types are returned as SQL_WCHAR, SQL_WVARCHAR, and
SQL_WLONGVARCHAR.

Note: Set the parameter to Ansi or Unicode if your third-party tool supports

only ANSI or Unicode strings.

Use Unicode Enables or disable Unicode support. The default value is True.

WireCompres,.

sion

Enables or disables compression of data over the wire at global or

individual database level. Use Connection Options to pass this

connection parameter, for example WireCompression=True. Disabled by
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3.6

default.
Note: You should place z1ib1.d11 in the same location as fbclient.d11.
SQLDialect Specifies the SQL dialect to be used when executing queries.

Downgrade
SQLDialect

Enables compatibility with an older version of the SQL dialect.

Sample Firebird ODBC Connection String

DRIVER={Devart ODBC Driver for Firebird};Data
Source=127.0.0.1;User ID=sysdba;Password=masterkey;Client
Library=D:\fbclient.d11;Database=D:\mydb.fdb

Sandboxed Apps on macOS

Sandboxed Apps on macOS

Sandboxed applications don’t have permission to access iODBC Driver Manager on macOS.
This is caused by the System Integrity Protection (SIP) technology on macOS which protects
your files and folders from potentially malicious software by locking the application. When
accessing a data source from an application like Excel through the ODBC driver for Firebird,

you may get an error message saying that the driver is unable to create a file.

Note: All third-party applications distributed through the Mac App Store are sandboxed.

Disabling System Integration Protection (SIP) on macOS

To resolve the issue, you should turn off SIP on your computer:

1. Restart your computer in Recovery mode (hold down Command + R until you see the
Apple logo).
2. Select Utilities > Terminal.

3. In the Terminal window, enter csrutil disable.
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3.7

[ ] O Terminal — -bash — 80x 24

-bash-3.2& csrutil disable

Successfully disabled System Integrity Protection. Please restart the machine fo
r the changes to take effect.

-bash-3.2# rebootf]

4. Restart your computer.

5. Enter csrutil status to check the status of SIP.

& & 3y test — paserver — -bash — BOx24

tests—imac-2:~ testd csrutil status
System Integrity Protection status: disabled.
tests—imac-2:~ tests I

Enable SIP after you finish working with an ODBC data source. To turn on SIP, enter csrutil

enable and restart your computer.

Using with iODBC

Using the Driver with iODBC

Among known issues with iODBC driver manager is incorrect handling of the following ODBC
data types:
e SQL_ WCHAR

e SQL_WVARCHAR
e SQL_WLONGVARCHAR

For this reason, we recommend using the following data types instead:
e SQL CHAR

e SQL_VARCHAR
e SQL_LONGVARCHAR

If you have to work with the SQL_WCHAR, SQL_WVARCHAR, and SQL_WLONGVARCHAR
data types, we recommend that you use the unixODBC driver manager rather than iODBC.
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3.8 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-Wide tracing for all user identities. For
example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open Control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

w

. If necessary, change the default Log File path. Make sure that the path is writable by the

application, then click app1y.
. Click start Tracing Now.
. Restart all application processes.
. Click Test connection in the DSN settings to make sure the driver is able to connect.
. Reproduce the issue.

. Click stop Tracing Now on the Tracing tab.

© 0o N O O

. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.
3. If necessary, change the default Log file path.

4. Select A1l the time in the when to trace option.
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3.9

Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the
[opBC] section of the /etc/odbcinst. ini file, for example:
[oDBC(C]

Trace=Yes
TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.

Usage Statistics

Usage Statistics

ODBC Diriver for Firebird can collect anonymous usage statistics. This data helps us improve
product quality, resolve issues faster, and better understand how our products are used.

The collected data is anonymous and does not include personal information. The amount of
transmitted data is minimal and is used only for diagnostic and product improvement
purposes.

Collected Data

The driver collects the following data:

¢ Product name and version.

e Name of the process (application) using the driver.

e License information: license type, license number, and license status.
e Operating system name and version, number of processor cores.

e An anonymous user identifier.

The user identifier is an internal ID generated only for statistical purposes. It is not the

operating system user name and cannot be used to identify the actual user.
e An anonymous hardware identifier.

The hardware identifier is an internal ID generated only for statistical purposes. It does not

contain any data that can identify specific hardware.
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e Database server name and version.

e Names of connection parameters used to connect to the database server.

Only parameter names are collected. We do not collect parameter values such as database

name, user name, or password.
e Connection result: success, or a numeric error code if the connection fails.

Only the numeric error codes are collected. We do not collect full error messages, which

might contain sensitive data (for example, database or user names).

Default Settings

Usage statistics is enabled by default when you install the driver.

To disable usage statistics, follow the instructions for your operating system:

e Enable or Disable Usage Statistics on Windows

e Enable or Disable Usage Statistics on macOS

e Enable or Disable Usage Statistics on Linux

3.9.1 Enable or Disable on Windows

Enable or Disable Usage Statistics on Windows

Usage statistics is enabled by default when you install the driver. You can disable it in one of
the following ways:

¢ During installation: In the installation wizard or from the command line.

e After installation: By editing the Windows Registry.

Disable Usage Statistics in the Installation Wizard

To disable usage statistics in the installation wizard, clear the Improvement Program

checkbox on the last page of the wizard. The checkbox is selected by default.
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ﬁ_."?'.-! Setup - Devart ODBC Driver —

Completing the Devart ODBC Driver Setup
Wizard

Setup has finished installing Devart ODBC Driver on your
computer.

[ Improvement Program™

ODBC Driver

Hedg 8 improve our products and §ix B Tasber by sharing a Emiled s of
ancynies data, inchuding Tunclionalily wsage slatstics, dagnostic nfomation, and
pesTarmance data,

Disable Usage Statistics From the Command Line

When you install the driver from the command line, you can disable usage statistics by
adding the /NousAGESTATISTICS parameter to the command.

Silent and Very Silent Mode

To disable statistics during silent or very silent installation with the EXE installer, run one of
the following commands:

DevartODBCFirebird.exe /NOUSAGESTATISTICS /SILENT
DevartODBCFirebird.exe /NOUSAGESTATISTICS /VERYSILENT

Quiet Mode

To disable statistics during quiet installation with the MSl installer, run the following command
as an administrator:

msiexec /i DevartODBCFirebird.msi /g NOUSAGESTATISTICS=true

Change Usage Statistics Settings in the Windows Registry

To enable or disable usage statistics for an installed driver, edit the Windows Registry as

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using ODBC Driver 77

follows:

1. Open the Registry Editor. To do this, press Win+R, type regedit in the Run dialog, and
press Enter.

2. Depending on your driver version, navigate to one of the following keys:

e 64-bit driver: HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBCINST.INI\Devart ODBC Driver for

Firebird

e 32-bit driver: HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\ODBC\ODBCINST.INI\Devart ODBC

Driver for Firebird

3. Set the value of the usagestatistics parameter to False to disable statistics, or True to

enable statistics.

3.9.2 Enable or Disable on macOS

Enable or Disable Usage Statistics on macOS

Usage statistics is enabled by default when you install the driver. You can disable it in the
installation wizard or later using a console application.

Disable Usage Statistics in the Installation Wizard

To disable usage statistics in the installation wizard, on the Registration page, clear the

Improvement Program checkbox.
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[ ] « Install Devart ODBC Driver for Salesforce ]
Registration

License information

Please enter the path to the file containing the activation key
Read Me received when purchasing the product. If you have no
activation key, select Trial Version.

Introduction

License
#® Registration Trial
Destination Select O Activation Key
Installation Type u1W7ICODSBNGAEOFabNziucK.JzVXGPYrkRYSHBT7Iv+thoF0387TUwn

RhweaiSanY siKzNH2irv1 LEAXNWT3rNhlAZ+L0/+1+i75BIGARSa0c=
Load Activation Key ...

Improvement Program®*

*Help us improve our products and fix issues faster by sharing a limited set of
anonymous data, including functionality usage statistics, diagnostic information, and
performance data.

Go Back Continue

Enable or Disable Usage Statistics in a Console Application

To enable or disable usage statistics using a console application:
1. In the console, go to the folder where the driver was installed. The default installation path

for the driver is /Library/0DBC/Devart/Firebird.

2. Run the activation command with superuser privileges using the -u option. Set the value to

false to disable usage statistics or true to enable it.
e To disable usage statistics: sudo ./firebirdodbcactivator -u false

e To enable usage statistics: sudo ./firebirdodbcactivator -u true

3.9.3 Enable or Disable on Linux

Enable or Disable Usage Statistics on Linux

Usage statistics is enabled by default when you install the driver. The graphical installer
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doesn't provide an option to disable usage statistics. You can disable statistics during
package installation or after installation using a console application.

Disable Usage Statistics During Package Installation

To disable usage statistics when installing a DEB or RPM package, set the
NOUSAGESTATISTICS environment variable to true.

DEB Package
To disable usage statistics when installing a DEB package, run the following command:

sudo NOUSAGESTATISTICS=true dpkg -i devartodbcfirebird.deb
RPM Package

To disable usage statistics when installing an RPM package, run the following command:

sudo NOUSAGESTATISTICS=true rpm -ivh devartodbcfirebird.rpm

Enable or Disable Usage Statistics After Installation

To enable or disable usage statistics for an installed driver, use a console application.

1. In the console, go to the folder where the driver was installed. The default installation path
is:
e DEB package: /usr/share/devart/odbcfirebird

e RPM package: /usr/local/devart/odbcfirebird

2. Run the activation command with superuser privileges using the -u option. Set the value to

false to disable usage statistics or true to enable it.

e To disable usage statistics:
sudo ./firebirdodbcactivator -u false -i /etc
®* To enable usage statistics:

sudo ./firebirdodbcactivator -u true -i /etc

3.10 Supported Data Types

Data Type Mapping

The Devart ODBC Driver for Firebird supports all Firebird data types.
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The following table describes how the Firebird data types are mapped to the ODBC data

types.

Firebird Data Types ODBC Data Types
INT64 SQL_INTEGER
TIMESTAMP SQL_TYPE_TIMESTAMP
DECIMAL SQL_DECIMAL
FLOAT SQL_REAL

BLOB SQL_LONGVARBINARY
INTEGER SQL_INTEGER
DECIMAL(18, 4) SQL_DECIMAL
CHAR(x) CHARACTER SET SQL VARCHAR
UNICODE_FSS

BLOB SUB_TYPE TEXT SQL_LONGVARCHAR
NUMERIC SQL_NUMERIC
VARCHAR(x) CHARACTER SET SQL_ VARCHAR
UNICODE_FSS

DOUBLE SQL_DOUBLE
SMALLINT SQL_SMALLINT
DECIMAL(10, 4) SQL_DECIMAL

CHAR SQL_CHAR
VARCHAR SQL_CHAR
CHAR(38) SQL_CHAR

3.11 Supported ODBC API Functions

Supported ODBC Functions

The SQLGetInfo function returns information about the driver and data source. To find out
whether a specific function is supported in the driver, call SQLGetFunctions.
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For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Firebird supports all deprecated functions for backward compatibility.

The following table lists the currently supported ODBC functions.

Function Name Support

SQLAllocHandle v,
SQLConnect v,
SQLDriverConnect v,
SQLAllocEnv v
SQLAllocConnect v

Standard

ISO 92

ISO 92

ODBC

Deprecated

Deprecated

Purpose
Obtains an

environment,
connection,
statement, or

descriptor handle.

Connects to a
specific driver by
data source name,
user ID, and

password.

Connects to a
specific driver by
connection string or
requests that the
Driver Manager and
driver display
connection dialog
boxes for the user.
Obtains an
environment handle
allocated from driver.
Obtains a

connection handle

ODBC API Calls for Obtaining Information about a Driver
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and Data Source

Function Name

SQLDataSources

SQLDrivers

SQLGetInfo

SQLGetFunctions

SQLGetTypelnfo

Standard

ISO 92

ODBC

ISO 92

ISO 92

ISO 92

Purpose
Returns the list of

available data
sources, handled by
the Driver Manager
Returns the list of
installed drivers and
their attributes,
handles by Driver
Manager

Returns information
about a specific
driver and data

source.

Returns the functions
supported by the
driver.

Returns information
about supported
data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes

Function Name

SQLSetConnectAttr

SQLGetConnectAttr

Standard
ISO 92

ISO 92

Purpose
Sets a connection

attribute.
Returns the value of

a connection
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attribute.
SQLSetConnectOpti Sets a connection
V' Deprecated
on option
SQLGetConnectOpti Returns the value of
v Deprecated
on a connection option
Sets an environment
SQLSetEnvAttr v ISO 92
attribute.
Returns the value of
SQLGetEnvAttr v ISO 92 an environment
attribute.
Sets a statement
SQLSetStmtAttr v ISO 92
attribute.
Returns the value of
SQLGetStmtAttr v, ISO 92
a statement attribute.
. Sets a statement
SQLSetStmtOption v Deprecated
option
. Returns the value of
SQLGetStmtOption v, Deprecated

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name Support Standard Purpose
Allocates a
SQLAllocStmt ' Deprecated
statement handle
Prepares an SQL
SQLPrepare ' ISO 92 statement for later
execution.

Assigns storage for
SQLBindParameter v ODBC a parameterinan
SQL statement.
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SQLGetCursorNam

e

SQLSetCursorNam

e

SQLSetScrollOption

S

ODBC API Calls for Submitting Requests

Standard

Function Name

SQLExecute

SQLExecDirect

SQLNativeSql

SQLDescribeParam

SQLNumParams

SQLParamData

ISO 92

ISO 92

ODBC

ISO 92

ISO 92

ODBC

ODBC

ISO 92

ISO 92

Returns the cursor
name associated
with a statement
handle.

Specifies a cursor
name.

Sets options that
control cursor

behavior.

Purpose
Executes a prepared

statement.
Executes a
statement

Returns the text of an
SQL statement as
translated by the
driver.

Returns the
description for a
specific parameter
in a statement.
Returns the number
of parameters ina

statement.

Used in conjunction
with SQLPutData to
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supply parameter

data at execution

time. (Useful for long

data values.)

Sends part or all of a

data value for a
SQLPutData v ISO 92

parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
about Results

Function Name Support Standard Purpose
Returns the number

of rows affected by
SQLRowCount v ISO 92

aninsert, update, or

delete request.

Returns the number
SQLNumResultCols v ISO 92 of columns in the

result set.

) Describes a column
SQLDescribeCol v ISO 92
in the result set.

Describes attributes
SQLColAttribute v ISO 92 of a column in the

result set.

Describes attributes
SQLColAttributes v Deprecated of a columnin the

result set.

Returns multiple

SQLFetch v, ISO 92
result rows.
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SQLFetchScroll v ISO 92
SQLExtendedFetch v Deprecated
SQLSetPos v ODBC
SQLBulkOperations v ODBC

Returns scrollable
result rows.

Returns scrollable
result rows.
Positions a cursor
within a fetched
block of data and
enables an
application to refresh
data in the rowset or
to update or delete
data in the result set.
Performs bulk
insertions and bulk
bookmark
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic

Information

Function Name Support Standard
SQLError v Deprecated
SQLGetDiagField v ISO 92

Purpose
Returns additional

error or status

information

Returns additional
diagnostic
information (a single
field of the
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diagnostic data
structure).

Returns additional
diagnostic
information (multiple
fields of the

diagnostic data

SQLGetDiagRec v ISO 92

structure).

ODBC API Calls for Obtaining Information About
Database Objects (Catalog Functions)

Function Name Support Standard Purpose
Returns a list of

o columns and
SQLColumnPrivileg

es

v, ODBC associated
privileges for one or
more tables.
Returns the list of

SQLColumns v X/Open column names in
specified tables.
Returns a list of
column names that

SQLForeignKeys .\/ ODBC make up foreign
keys, if they exist for
a specified table.
Returns the list of

SQLPrimaryKeys v ODBC column names that
make up the primary

key for a table.
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SQLProcedureColu

mns

SQLProcedures

SQLSpecialColumn

S

SQL Statistics

SQLTablePrivileges

v ODBC

v ODBC

' X/Open

v ISO 92

v ODBC

Returns the list of
input and output
parameters, as well
as the columns that
constitute the result
set for the specified
procedures.
Returns the list of
procedure names
stored in a specific
data source.
Returns information
about the optimal set
of columns that
uniquely identifies a
row in a specified
table, or the columns
that are
automatically
updated when any
value inthe row is
updated by a
transaction.
Returns statistics
about a single table
and the list of
indexes associated
with the table.

Returns a list of
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tables and the

privileges

associated with

each table.

Returns the list of

table names stored
SQLTables v X/Open

in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard Purpose
Commits or rolls
SQLTransact v Deprecated
back a transaction
Commits or rolls
SQLENndTran v, ISO 92

back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard Purpose
Ends statement

processing, discards
pending results, and,
SQLFreeStmt v ISO 92 optionally, frees all
resources
associated with the
statement handle.
Closes a cursor that
SQLCloseCursor v ISO 92 has been opened on

a statement handle.

SQLCancel v, ISO 92 Cancels an SQL
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statement.

ODBC API Calls for Terminating a Connection

Function Name Support Standard Purpose
. Closes the
SQLDisconnect v ISO 92
connection.
Releases an

environment,
SQLFreeHandle ' ISO 92 connection,

statement, or

descriptor handle.

Releases connection
SQLFreeConnect v Deprecated

handle.

Releases an

SQLFreeEnv v Deprecated
environment handle.

Using in Third-Party Tools

This section discusses how to use ODBC Driver for Firebird with ODBC-compliant tools.

e DBeaver
e DBxtra

e Denodo

Informatica PowerCenter

Microsoft Access

Microsoft Excel

¢ Microsoft Visual Studio

¢ OpenOffice and LibreOffice

e Oracle Database Link
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e PHP

e Power Bl
e Python
e QlikView

e SQL Server Management Studio

e SSIS

e Tableau

41 Using in DBeaver

This section describes how to connect DBeaver to Firebird using Devart ODBC Driver for
Firebird.

e Connect DBeaver Community to Firebird through ODBC

e Connect DBeaver Enterprise to Firebird through ODBC

411 Connect DBeaver Community to Firebird through ODBC

DBeaver Community and DBeaver Enterprise let users connect to Firebird via ODBC,
enabling SQL-based querying, reporting, and data management.

If you need basic ODBC connectivity to Firebird and are comfortable with manual
configuration using a generic ODBC Connection, choose DBeaver Community—a free, open-
source database management tool.

If you require a simplified connection setup with built-in ODBC support, enhanced security,
and performance features, you may try DBeaver Enterprise. For more information on
connecting to Firebird data from DBeaver Enterprise, see Connect DBeaver Enterprise to
Firebird through ODBC.

Initial configuration

1. Download jdbc-odbc-bridge-jre7.jar and x64/3dbcodbe.d11 from Github.

2. Download the Microsoft Visual C++ 2010 Service Pack 1 Redistributable Package

from the Microsoft website.
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The built-in legacy ODBC driver was removed in DBeaver Community Edition 23.1. If you're
using an earlier version of DBeaver Community, skip steps 1 and 2.

3. Configure an ODBC data source. For more information, see Windows DSN Configuration.

4. On the Advanced Settings tab of the DSN configuration window, select Ansi from the

String Types.

This option is required for the proper display of the SQL_WVARCAHAR data type in DBeaver.
It also ensures that all string types will be returned as SQL_CHAR, SQL_VARCHAR, and
SQL_LONGVARCHAR.

Devart ODBC Driver Configuraticn et
General Advanced Settings Tracng License About

Metadata
B Empty Strings as MULL B allow MULL Strings

[ Return Foreign Keys {may significantly degrade performance)

Cache Metadata 1 Day ke
Connection

Connection Timeout &0 [ UTC Dates
Query Timeout ] [ Indude Deleted

Use Local Regional Settings when converting to string

[ ] Mumbers [ | Dates and Times
Compatibility

ODBC Behavior Default b

String Types |.ﬁ.nsi (SQL_CHAR, SQL_VARCHAR, SQL_LONt ~

Test Connection - Cancel

Connect to Firebird

1. In DBeaver, select Database > Driver Manager.

2. Click New.
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=% Driver Manager

Type part of database/driver name to filter

Mame Copy
W saLite 1
1 Altibase Edit ...
@ Apache Calcite Avatica Delete
& Apache Ignite =
# Apache Kylin Un-delete
> B3 AWS
» M4 Azure 7 - User defined

& Arure Databricks & - Unavailable

Q Babelfish via TDS (beta)
[| Cache
= (Cassandra
ClickHouse
ClickHouse (Legacy)
A% Clondhern:
Generic provider

Close

3. Configure the following properties for a new driver:

¢ |n the Driver Name field, enter ODBC.
¢ |In the Class Name field, enter sun.jdbc.odbc.JdbcOdbcDriver

¢ In the URL Template field, select jdbc:odbc:{database}.
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@ Create new driver

Settings | Libraries | Default properties | Advanced parameters

Driver Name:  ODBC Driver Type: | = Generic v

Class Mame: sun,jdbc.odbe)dbcQdbeDriver

URL Template: jdbciodbo{database}
Default Port:

Default Database:

Default User:

[[JErmbedded [] Propagate driver properties [_] No authentication [_JiAllow Empty Password:
[[] Use legacy JDBC instantiation [ Thread safe driver

Description

1D 55052241-1D12-5734-4177-5C2F49673070

Description:

Reset to Defaults Cancel

4. On the Libraries tab, click Add File.

5. Select the jdbc-odbc-bridge-jre7.jar, then click OK. After that, select 3dbcodbc.d11, then
click OK.
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(@) Create new driver

O X
Settings | Libraries | Default properties | Advanced parameters
s Ci\Users) \Downloads\download_files\jdbc-odbc-bridge-jre? jar hdd File
En C\Usersy \Downloadshdownload_files\JdbcOdbe.dll s
Add Folder
Add Artifact
Edit ...
Delete
Download/Update
Information
Classpath
Driver class: ~ | Find Class Export
Reset to Defaults oK

Cancel
[

6. Once a new ODBC driver appears on the list, click Close.
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<% Driver Manager 0O e

Type part of database/driver name to filter

Mame # Copy

MDB Cluster

® Neodj Edit ..

M Metezza Delete
MucDB -

c8 OceanBase Un-delete

O Ocient

E ODBC T - User defined

= ODBC - Legacy B - Unavailable

E] Omnisci (formerly MapD)
:.) Open Distro Elasticsearch
8. OpenEdge

h_-"j OpenSearch

E Cracle

MirientE

Close [:?

7. Select Database > New Database Connection.
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(g) DBeaver 24.3.5
File Edit Mavigate Search 50LEditor Database Window Help
¢ - JsaL ~

f® Database Navigator [ Projects

e—1

Mew Database Connection

Mew Connection from JDBC URL

0w

Driver Manager

Enter a part of object name here

Disconnect All

Open Dashboard

% B

Tools
Context tools
& Tasks

8. Select the ODBC driver, then click Next.

= O x
Ctrl+Shift+ M | s
=5
Ctrl+ Alt+5Shift+ B
>
Alt+"
* T|en
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| ) Connect to a database O >

Select your database

Create new database connection. Find your database driver in the list below.

Type part of database/driver name to filter ¥ | Sortby: O Title €@ Score
|
2 Al ¥y d ™ |
Ty crn® ORACLE
& Popular MariaDB MySQl
EN SOL
D2 for LUW MaraDB MySOL Oracle
B NoSQL
EN Analytical
EN Timeseries :‘;_;.‘23 AlTisase
N Embedded ﬁ‘ﬁﬂkﬁ,e
rver
“F Hadoop / BigData ! ~
PostgreS0L SOL Server S0Line Alibaze Apache Calcite
Auatica
-
Test Connection ... < Back Mesxt = Finish Cancel

9. In the Database/Schema field, specify the name of your DSN.
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Generic JDBC Connection Settings
ODBC connection settings

Main | Driver properties | 55H

General
Connect by: © Host (JURL

Jjdbc:odbo:DEEAVER_DATASOURCE
Database/Schema: DBEAVER_DATASOURCE

-+ Metwork configurations...

Authentication (Database Mative)

Username:

Password: B Save password

(1) Connection variables information

Driver name: ODBC

Test Connection ... < Back

Connection details (name, type, ... ]

Driver Settings

m
-

10. Optional: Select Test Connection to verify the connection settings.

E Connection test

Driver: JDBC-ODBC Eridge (DevartODBC
(03.04.0200)

11. Click Finish.

The database appears on the left pane.

=

.dil) 2.0001

Details ==

12. To view the data stored in a table, expand the database structure and click the needed

table.
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(%) DBeaver 24.3.5 - Account = a X
Eile Edit Mavigate Search 50OLEditor Database Window Help
¢ v| ¥ & | Osa ~i[ Commit [RFRollback T ~ @ Auto  |€0 v DBEAVER DATASOURCE v [E <N/A> v @y~ & v Q v
Q ®|@
f® Database Mavigator 3 [ Projects = O FBAccount X S5 DBEAVER_DATASOURCE B8 Solution = 0
= FF Properties | ) Data ﬁg-n ER Diagram|
Enter a part of object name here v - -
« =, DBEAVER DATASOURCE EEAC(UU”tlzs- nression to filter results (use Ctri+Space » |v e d T = =
~ [ Tables | [z o) . V‘AZV|A-!NHI! V|A-ZV|A-ZV|AZV|AZV|AZV| [ Value X i |
o
’ ;i“e"ti"a’e"me'““’” fH 118 0012400 [1  [MULL] Kate West (Sample) Custorr [MULL Kings P [NULL B R |
’ ceoun — 19 002400 [ ] [MULL] Kate West (Sample) Custorr [MULL 9 Tagor Singapt Smgap: 00108000020EKXLA & |2
5 9 AccountChangebvent b1 E AD
s M AccountCleanlnfo — 120 oo2400 [ ] IULL] Kate West (Sample) Custor [MULL 312 Cor Austin TX gg
5 FM AccountContactRole [_3' 121 oo2400 [ ] [ _ Kate West (Sample) Custorr [MULL 5255, L Bur.ling' NC ®
5 [ AccountContactRoleChangeEvent 122 oo2400 [ ] IULL] Kate West (Sample) Custorr [ULL 2 Place Paris IULL i
5 M9 AccountFeed = 123 0012400 [ ] IULL] Kate West (Sample) Custorr [MULL 1301 He Lawren KS N
s B9 AccountHistory 2 124 | 001240 []  [MULL] KateWest (Sample) Custorr [MULL 2334 N. Chicag: IL B
5 FA AccountPartner E 125 oo2400 [ ] [MULL] Kate West (Sample) Custorr [MULL 620 SW Portlan OR
» B8 AccountShare 126 0012400 [ ] IULL] Kate West (Sample)  Custor [MULL 838 N E Tucson AZ
» B8 ActionLinkGroupTemplate 127 0012400 [ ] [MULL] Kate West (Sample) Custorr [MULL 1307 Av New Yc NY
» A ActionLinkTemnplate 128 oo2400 [ ] IULLT Kate West (Sample) IULL] [MULL. The Lar San Fra CA
> FA ActiveFeaturelicenseMetric 129 | 0011p00 [ ] JULL] Kate West (Sample) [NULL] [NULL) [NULL] [MULL] [NULL
» A ActivePermSetLicenseMetric 120 nninant 11 1 Kate Weet (Samnlel 1 1
3 B3 ActiveProfileMetric int
5 E2 ActivityFieldHistory @ Refresh v | () Save v Cancel = S i@ = il¢ € » U X Exportdata ~ | €8
5 A ActivityHistory - -
200 Z 200+ : () 200 row(s) fetched - 0.653s (0.061s fetch), on 2025-02-19 at 17:20:16 - 5 waming(s) l‘_‘\
S, DBEAVER_DATASOURCE » FF Account Table: Announcement | EET | en
1. Select SQL Editor > New SQL script.
(&) DBeaver 24,35 - Solution - ] X
File Edit Mavigate Search 50L Editor Database Window Help
¥ -‘ Ve q| [Jsc [J OpensaLscript F2
Last edited SOL script Ctrl+Enter
DBEAVER_DATASOURCE - |: E . ’ Q @ | @
[ New SOL script Ctrl+]
- i =
£= Database Navigator X [ Open 50L console Cirl+Alt+Enter =
. Panels >
Enter a part of object name here ST~ o
L/ - - J
5 B8 Seclution Rayoul 2 |
s+ [ SolutionFeed Context 3 ¥ | Az Solutiont [y x| = x|
» SelutionHisto -
g SalutionStat 7 A T— BB =
» olutionStatus uto-sync connection with navigator 00000002 5012400000 o |2
» E5 Stamp Open separate connection > 00000003 OcvwCzAA| S5
» FH StampAssignment . =0 Y LL
» B StaticResource - E [] @
» B3 StreamingChannel 3 30124000000cvD3AAI [ 00000003 5]
» B3 StreamingChannelShare ] 30124000000cvDAAAI [] 00000006 E
s+ [ TabDefinition E 7 50124000000cwD5AA] [] 00000007
> E TabledVerify_c E E
» o TabledVerify__ChangeEvent I ] @ Refresh ~ @ () Save = Cancel : =5 Z4 If ==
» 3 TableauHostMapping
r . -
» [ TableauHostMappingShare HE € > M b d, Exportdata ~ g 200 X 0

« A Tack

=% » B2 Solution  Table: TaskPriority

10 row(s) fetched - 0.241s (0.003s fetch), on 2025-02-24 at 16:15:48

|EI-_—I'|en

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools

2. Enter your query.

101

() DBeaver 24.3.5 - <DBEAVER DATASOURCE> Script-2 = [m] x
File Edit Mavigate Search 50l Editor Database Window Help
L3 v| ¢ ¢ [Jsa ~i[} = | T ~ @ | Aute |40 v DBEAVERDATASOURCE ~+ [H]<N/A> + 3~ & » Q ~
Q B|@®
f® Database Navigator 3 [ Projects = B & DBEAVER_DATASOURCE P Solution [, *<DBEAVER_DATASOURCE> Seript-2 3 = 0
= & E [ 3 SELECT SolutionName, SolutionNote FROM Solution,‘|
Enter a part of object name here ¥ - ».
> B8 Site o]
> B8 SiteDetail -
» A SiteFeed -
» P SiteHistory
» A SitelframeWWhiteListUrl
> FH SiteRedirectMapping
» E2 Solution
5 A SolutionFeed
» F2 SelutionHistory
» A SolutionStatus
» B8 Stamp
» FH StampAssignment
» A StaticResource e ]
> FH StreamingChannel
» F2 StreamingChannelShare
B
» F2 TabDefinition I
» B8 TabledVerify_c I}
> FX TabledVerify_ ChangeEvent =
3 A TableauHostMapping HE
EET | en | Writable Smart Insert 1.8
3. Select SQL Editor > Execute SQL query.
The query results are displayed in the main window.
() DBeaver 24.3.5 - <DBEAVER DATASOURCE> Script-2 = [m] x
File Edit Mavigate Search SOLEditor Database Window Help
& v| oW [Jsa - t 2 T @ Auto |49 v DBEAVER DATASOURCE ~ [ <N/A> ~ iy~ &b viQ ~
Q B|@®
f® Database Navigator 3 [ Projects = B & DBEAVER_DATASOURCE P Solution [, *<DBEAVER_DATASOURCE> Seript-2 3 = 0
=+ 8 » SELECT SolutionName, SolutionNote FROM Solution;|
Enter a part of object name here ¥ - ».
> B8 Site 3
> B8 SiteDetail m
» A SiteFeed
s 3 SiteHistory T SELECT SolutionMame, Solu | § 5 £nt to filt t t b v | 2T~ - -
» B9 SitelframeWhiteListUrl = | 22 SolutionName w | Az SolutionNote -  Value X = g
SiteRedirectM had 2
z ; Sloleu‘tleo:e wdld, isij GC1020 Portable Generator Switch Mal‘fud If the generator switch is not working, rerr [ U =] =0 “3_’0
. & Generator assembly instructions unclear  The Maintenance Manuals for the GC1020 GC1020 Portable | & | &
5 A SolutionFeed g
s E3 SolutionHistory - 3 Maintenance guidelines for generator unc The Maintenance Manuals for the GC1060 -
» [ SolutionStatus E 4 Selecting the Right Generator for Your Nee GenWatt offers a wide range of electric ge @)
» [ Stamp 5 GC3000 Series Propane Generator Ignition The GC3000 series propane generators nee A
> FE StampAssignment & Starting generator after electrical failure  After an electical failure, the generator has N
> FF StaticResource 7 Electrical wiring installation for GC5060  The red wiring from the top electronic par iz
» F2 StreamingChannel s GenWatt SLA Commitments GenWatt offers four different SLAs with dil =,
» F2 StreamingChannelShare é 9 Electronic panel fitting loose On the GC3020, the electronic panel is knc
» FH TabDefinition | g 10 GenWatt Installation Services GenWatt Corporation has a full-service su|
» F3 TabledVerify_c -
> B8 TabledVerify_ChangeEvent @ Refresh e v SR m =il < oo : 1 Exportdata ~ 3
> FA TableauHostMapping
200 XY o10: 10 row(s) fetched - 0.378<, on 2025-02-19 at 18:34:18 [ Ja}
EET | en | Writable Smart Insert 1.8
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41.2

Connect DBeaver Enterprise to Firebird through ODBC

DBeaver Enterprise and DBeaver Community let users connect to Firebird via ODBC,
enabling SQL-based querying, reporting, and data management.

If you require a simplified connection setup with built-in ODBC support, enhanced security,
and performance features, you may try DBeaver Enterprise.

If you need basic ODBC connectivity to Firebird and are comfortable with manual
configuration using a generic ODBC connection, choose DBeaver Community—a free, open-
source database management tool. For more information on connecting to Firebird data from
DBeaver Community, see Connect DBeaver Community to Firebird through ODBC.

Connect to Firebird

To connect to the Firebird database from DBeaver Enterprise:

1. Select Database > New Database Connection.

2. Select the ODBC driver and click Next.
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) Connect to a database O x
Select your database
Create new database connection. Find your database driver in the list below.
Type part of database/driver name to filter & | Sortby: (O Title @ Score
|
£ Al ST §
E P la ‘:::E-F ‘: [y 1\-\: I
i MariaDB MySQL
Em saL )
Db2 for LUW MariaDB MongoDB MySOL
N NoSOL
£ Analytical
0 Timeseries St 4 b ?&Z’
8 Embedded ORACLE op-o oL G
4 h SOL Server
= Oracle Postgres0L Redshift Snowflake SOL Server

Test Connection ... < Back Finish Cancel

3. In the Database Source field, specify the name of your DSN.
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@) Connect to a database O *
ODBC Connection Settings 0 D
ODEC connecticn settings BC
Main | Driver pruperties| 55H| = Metwork configurations...
Connection
Type: @ Data Source () Manual
Data Source: ‘ DEEAVER_DATASOURCE |

(i) Open ODBC Administrator tool

Authentication

Authentication: Database Mative -

Lzername:

Password: B Save password @
(E} Connection variables information Connection details (name, type, ... )
Driver name: ODBC Driver Settings

Test Connection ... < Back MNext = Cancel

4. Optional: Select Test Connection to verify the connection settings.

E Connection test O X

@ Connected (6527 ma)

Serven N

Driverr DBeaver JDBC-ODBC Bridge (DevartODBC" o «.dlf)
1.0.71 (03.04.0200)

Details ==

5. Click Finish.
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The database appears on the left pane.

105

6. To view the data stored in a table, expand the database structure and click the needed

table.

@ DBeaver Enterprise 24.3.0 - Account

£0) ~ ' [J] DBEAVER DATASOURCE ~ [E] < N/A >

File Edit Mavigate S5earch 50l Editor Database Window Help
€| v v Osa - T e A
f® Database Navigator X [ Projects = O B Account X [FB AccountChangeEvent
. P
=+ 3 F2 Properties | £} Data D-Eﬁ ER Diagram
Enter a part of object name here h

[m]

X

o -m-avia-

Q B|@

=

-

2

« [ DBEAVER_DATASOURCE F Account |33 PIr| BT~
~ [ Tables | Z| o rzv|azbiingstest - ‘ 2z BillingCity ¥ ‘ A2 Billingstate | [ valve x| =
z g:z:zidEventRelatmn =K Al - B Eﬂ E
> E AccountChangeEvent % 2 312 Constitution PlaceTAustin, TX 78767TUS/ Austin T® UK
5 M9 AccountCleaninfo e 3 888 N Euclid THallis Center, Room 501TTucse Tucson A7
» [ AccountContactRole [T‘;' 4 2 Place Jussieu Paris
5> F AccountContactRoleChangeEvent £ 5 The Landmark @ One Market San Francisco CA
5 F AccountFeed S 6 2334 N, Michigan Avenue, Suite 1300TChicac Chicago IL
> B8 AccountHistory Y 7 9 Tagore LanellSingapore, Singapore 7874721 Singapore Singapore
» A AccountPartner 2 345 Shoreline ParkTMountain View, CA 8404 Mountain View CA
» (A AccountShare 9 1301 Avenue of the Americas TMNew York, NY Mew York NY
5 FH ActionLinkGroupTemplate 10 1301 Hoch Drive Lawrence KS
» E ActionLinkTemplate 1 525 5. Lexington Ave Burlington NC
> 3 ActiveFeaturelicenseMetric 12 620 SW Sth Avenue Suite 400TPortland, Oreg Portland OR
> 3 ActivePermSetLicenseMetric -g 13 Kings Park, 17th Avenue, Team Valley Tradin :
» [ ActiveProfileMetric ‘15
> FH ActivityFieldHistory £ —
> FH ActivityHistory
> 9 AdditionalNumber @ Refresh v © - wm=ilK < > > I Exportdata ~
s P Address 5
200 RARER - 13 row(s) fetched - 0.209s (0.057s fetch), on 2025-02-20 at 20:3%:07
EET | en

Query Firebird data

1. Select SQL Editor > New SQL script.

m]

Eﬂ DBEAVER_DATASOURCE [ Tables ~ [T Account

4

M@ ([ @ 58 |seuedid
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() DBeaver Enterprise 24.3.0 - Solution - O X
File Edit MNavigate Search SOLEditor Database Window Help
¢ ‘ 9 # % | Osc O OpensaLscript ER
- . i
: m DBEAVER DATASOURCE 15 Last edited SQL script Q M | @
T New SQL script Ctrl+]
& Database Navigator = Open 5L console = 0
Enter a part of object name here — B
> [0 SlaProcess Layout > DATASQURCE [ Tables = [T Solution
v E5 Solution Select active schema erresh |[v| BT v dm~ =~
> v Celumns o o ) '
> [ Keys £+ connection Trom navigator v | az Solutionh ¥ | Az Solutionh v | e |
> I Foreign Keys Auto-sync connection with navigater 00000010 GenWatt Install = &
[
>l I:;exes To e 5 00000001 GC1020 Portabl | &
> ferences = s | VIV I LELW Ll 00000002 Generator asser 29
» B SolutionFeed = ®
» FH SelutionHistory - T e
R h = : Save w [®] Cancel : = =3 = —
» BB SolutionStatus | E @ Refres O b Can ISy 24 CH S =
> EB SPSemiAttributes o i< < > Ol M it bpordaa vigk 20 X 10 i
» 8 Stamp 9 -
) 10 row(s) fetched - 0.264s (0.016s fetch), on 2025-02-24 at 16:40:38 =
- I I
2. Enter your query.
(@) DBeaver Enterprise 24,3.0 - <DBEAVER_DATASOURCE> Script = a X

File Edit Mavigate Search 50L Editor Database Window Help
¢ v| % & N | [Tsat =:i[} Commit [ Rollback T~ & Auto o EDBEAVER_DATASOURCE - <NA> v~~~ ~iQ ~
Q i®|l@®

= Database Navigator ¢ [ Projects = B [ Account A AccountChangeEvent Q *<DBEAVER_DATASOURCE> Script ¢ =
§

= & ] SELECT SolutionName, SolutionNote FROM Snlutinn,‘|

1Y) Iy (G sepung === | oupy [T O

Enter a part of object name here N
w DBEAVER_DATASOURCE
v [ Tables I
> FH AcceptedEventRelation
» A Account
» B2 AccountChangeEvent
» 2 AccountCleaninfo
5 A AccountContactRole
» 2 AccountContactRoleChangeEvent
» FA AccountFeed
» FH AccountHistory
» B8 AccountPartner
» B8 AccountShare
> F2 ActionLinkGroupTemplate
» F2 ActionLinkTemplate
» B8 ActiveFeaturelicenseMetric n
» A ActivePermSetLicenseMetric
» A ActiveProfileMetric B
> BB ActivityFieldHistory
> FH ActivityHistory )
5 [ AdditionalMumber [
o= v
5 P Address 0= < . 0‘)

| EI:T| en | Writable | Smart Insert 1:49:48 Sel

M@ lmE >

3. Select SQL Editor > Execute SQL query.

The query results are displayed in the main window.
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@ DBeaver Enterprise 24.3.0 - <DBEAVER_DATASOURCE> Script = a x
Eile Edit Mavigate Search 50LEditor Database Window Help
L3 v| & W | [Jsa ~ T v @i Auto |4D v [FIDBEAVERDATASOURCE ~ El<N/A> v @~ @l v & v Q ~
Q B|@
f® Database Mavig.. » [ Projects = B FH Account 8 AccountChangeEvent [, *<DBEAVER_DATASOURCE= Script % = 8
= & | 3 SELECT SolutionName, SolutionNote FROM Solution; D
Enter a part of object name here T~ =
=
~ [ DBEAVER_DATASOURCE =
v [ Tables | B solution1
> FH AcceptedEventRelation T SELECT SolutionName, Solt | 5 2 P lw| B T v =~
» [ Account ——
5 F9 AccountChangeEvent E = | a7 SelutionName | a7 SelutionNote ¥ | T Value X = g
> 8 AccountCleaninfo M O | GenWatt Corporation has a full-service suppc | U= 0 ":,_?
> 8 AccountContactRole o 2 GC1020 Portable Generator Switch Malfunctior If the generator switch is not working, remowe Geniatt Instal =
> F3 AccountContactRoleChangeEvent 273 Generator assembly instructions unclear The Maintenance Manuals for the GC1020 are =
> B Ac(ountFe.ed [?;' 4 Maintenance guidelines for generator unclear  The Maintenance Manuals for the GC1060 are ®
> B icmuntslstor)r + 5§ Selecting the Right Generator for Your MNeeds  GenWatt offers a wide range of electric gener i
’ g Accounts:rtner é 6 GC3000 Series Propane Generator Ignition The GC3000 series propane generators need t i
? c(.nun. are 27 Starting generator after electrical failure After an electical failure, the generator has to i)
» B3 ActionLinkGroupTemplate . L . ™ + =]
Lo 8 Electrical wiring installation for GC5060 The red wiring from the top electronic panel ¢ =
» FE ActionLinkTemplate = . . ; d
5 FF ActiveFeatureLicenseMetric s 9 Electronic panel fitting loose On the GC3020, the electronic panel is known
5 O ActivePermSetLicenseMetric 3:: 10 GenWatt SLA Commitments GenWatt offers four different SLAs with differ
» B8 ActiveProfileMetric il [—
» FH ActivityFieldHistory @ Ref 3 ] :
resh - : - T R T, Exportdata ~ :
> B Ackhiybitory B . W= > 2  Bxp X
200 x 10 : =10 row(s) fetched - 0.35%s, on 2025-02-20 at 20:46:03 l‘_\
EET | en | Writable Smart Insert 1:45:48 Sel

4.2 Using in DBxtra

Troubleshooting Firebird ODBC Connection in DBxtra

This page explains how to troubleshoot your ODBC connection to Firebird in DBxtra.

Due to incompatibilities between DBxtra and Firebird, leaving the sqQL dialect property to its
default might present various issues. To resolve compatibility issues, set the property to ms
Access 2000/XP/2003 Or ANSI sqQL/2ee3 for DBxtra version 11.0.1 or newer, and to ANST
sqL/2ee3 for versions prior to 11.0.1.
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Connect through ODBC E3

NOTE:

Imiportant!

Due to incompatibles, selecting the Auto SQL dialect might present various
problems using the Auto SCL dialect with some database servers.

Please be sure to select the right SQL dialect for your connection.

Connection name |MyData

Data source |DataSource 1 III

User

Password

Connection timeout | 15| 5| sqL dislect| | MS Access 2000/... |w |

Enable Offline Mode

Get columns descriptions
Select User Groups who can view this Connection

[#]accounting n
[]contraling

Guest Group

[~ILegal

Management

[#IManufacturing

[#Marketing

[Purchasing W

Select Al Unselect Al Cancel

4.3 Using in Denodo

Troubleshooting ODBC Connection in Denodo

When you attempt to access Firebird from Denodo with default settings, you may get an
'‘Unexpected error creating a connection: Unable to validate object Received exception with
message 'Unable to validate object". To resolve the error:

1. Select File > New > Data Source > ODBC in Virtual DataPort Administration Tool.

2. Click Connection Pool configuration.
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3. In Ping query, change select 1 {0 Select 1 From DB$DATABASE, then click Ok.

g *new_datasource

Connection Pool Configuration

Initial size: 4
Maximum number of active connections: 20
Test connections
Select 1 From DBSDATABASE|

Ping query:

44 Using in Informatica PowerCenter

You can access Firebird data from Informatica PowerCenter on Windows and Linux.

e Connect Informatica PowerCenter to Firebird on Windows

e Connect Informatica PowerCenter to Firebird on Linux

441 Connectto Informatica PowerCenter on Windows

You can connect Informatica PowerCenter to Firebird through an ODBC driver on Windows
to unify and manage data across these systems.

Prerequisites

e Configure the Informatica services.

¢ |nstall the PowerCenter Client tools.
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e Create a repository folder in PowerCenter Repository Manager.
e |nstall Devart ODBC Driver for Firebird. For instructions, see Installation.

e Configure a data source name (DSN). For instructions, see Windows DSN Configuration.

Add a data source in Informatica PowerCenter

Before you proceed, make sure PowerCenter Designer isn't running.

1.Open-the.c: \Informatica\10.4.1\clients\PowerCenterClient\client\bin\powrmart.ini-file

in a text editor.
2. In the [obBcDLL] section, add Firebird=PMODBC.DLL, then save the changes.
3. Open PowerCenter Designer.
4. Double-click the repository name (in this example, PCRS), enter your Informatica

credentials, then click Connect.

0 nformatica PowerCenter Designer - [Start Page] — O K
0 Repository Edit View Tools Versioning Windows Help = =] 3
9a | - Elx|rRar | = E )
(RYDIWEM] | s Pe 5 @ N

==l

& Repositories

S B [P (‘ Informatica'| PowerCenter 10 ®

Getting Started Resource Center
Mew Features and Enhancements Informatica.com
Product Overview Informatica Netwark
Connect to Repository x
Connect to Repository
Repositary: PCRS Cancel
Username: | USERNAME ‘ Help
0
I | | = Incements
’ =5 More =3 .
] ) - Frirees B predictive analytics,
Security Domain: Native = E, and integrated health

Homains.

Sign Up now to start using Operational Insights.

Copyright & 1853-2020 Informatica LLC. All Rights Reserved

x|
|

Ill 4 I PI NI\ Save AFetch Log )\Geﬂeraie )\\u"alidaie ]\ Debugger )\Session Log )\ Motifications / ‘I < >
Recdy [ o]

5. Double-click the repository folder (in this example, ODBC connections), then select
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Sources > Import from Database.

G) Infermatica PowerCenter Designer - [Source Analyzer - ODBC connections - [PCRS]] - m]

@Reposltory Edit View Tools Layout Versiening Sources Window Help - 0 X

[ ODBC connections - [PCRS] I |- Import from Database... A =2 &L =

\= Import from Eile...
0 0 @ @ b ﬁ Import frem Cobel File..
o | 5.3& Import XML Definition...
&= Repositories

B & PCRS Ga
B B Import From PeopleSoft ...
i [ Business Components
B Sources ‘Web Service Provider 4
[ Targets Import from Powerbxchange...
) Cubes Import From Salesforce
& D\meﬂslons. Import From AmazenRSCloudAdapter
i Tiensformations Import From AmazenS3Plugin
B Mapplets i
1 Mappings Import frem Informatica Cloud...
[ User-Defined Functions Create PowerExchange for BigQuery Source...
Create PowerExchange For Snowflake Source...
Create PowerExchange for Microsoft Dynamics 365 for Sales Source..
Create PowerExchange for Goegle Cloud Spanner Source...
Create PowerExchange for Goegle Analytics Source...
Create AzureDWv3 Source...
Create PowerExchange for Google Cloud Storage Source..,
Create PowerExchange For PostgreSOL Source..,
Create PowerExchange for Kafka Source...
Create MongoDB Source...
Create 5APTableReader Source...
= Create...
< |_‘§1 Compare...
x|
=]
| ‘ | [\Save AFetch Log )\Generate ,\Validate }\Debugger l,\Se:isiorl Log f\ Notifications / H <
Import frem a given database NUM

The Import Tables dialog opens.
6. From the ODBC data source menu, select the needed DSN.
7. In the Username and Password fields, enter your Firebird credentials.
8. Under Show owners, select All.

9. Click Connect.
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Import Tables >

Connect to Database

ODBC data source: | PRE-COMFIGURED _DSM (Devart ODBC Driver for |~ ...

|Jse Kerberos Authentication Cancel
Username: | USERNAME | Help
Owner name: <ALL=
PaSSI.ﬂ,Iﬂrd: | ------------| |
Select tables

Show owners:

Default

Search for tables named:

I:I Search

Select all

Select naone

10.In the Select tables section, expand the tree and select the tables you want to import.

11.Click OK.
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Import Tables >

Connect to Database

ODBC data source: | PRE-COMFIGURED _DSM (Devart ODBC Driver for |~ |...

Cancel
|Jse Kerberos Authentication
Help
Username: | USERNAME | Z
Owrer name: <ALL > ==
Easswurd: | (121221173 7%] | F'.E—t_:ﬂr‘lﬂECt
Select tables
=-0 -iBLES * | Show owners:
----- 1] AcceptedEventRelation
----- Biiil Account — =z
""" EEE AccountContactRelation Search for tables named:
----- I AccountContactRole emch
----- fif] AccountFeed I:I
g1 Accounttistory |
----- gia) AccountPartner
----- if] AccountShare
----- [ ActionLinkGroupTemplate Select al
----- [{f] ActionLinkTemplate W
< 3 Select none

The table schemas appear in the Source Analyzer, and the data source is added to the
Sources subfolder of the repository folder. You can now create mappings and work with

Firebird data in Informatica PowerCenter.
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0 Informatica PowerCenter Designer - [Source Analyzer - ODBC connections - [PCRS]] - ]
5’:’) Repository Edit  View Tools Layout Versioning Sources Window Help - & x
[ ODBC connections - [PCRS-LIN] ~ | @ .)“15 100% ~ £ @ '5; 'QD ':»éa
QDO | L5
=l El
E Repositories @ J& @ 83
T RS [CISRIODE) [
=] @ ODBC connections K Name Datatype ™
i [ Business Components
3 Id nvarchar
@ Sources s Deleted bit
& MasterRecord SRS ODRCI = =)
B Tergets Name K Name Datatype ™
-« [ Cubes Type o N
B Dimensions nvarchar
. - Parentld nvarchar
D N meens N SRR O0) )
- [ Mapplets pe 5 H
i Mappings greate:g\"ld K Name Datatype ™
H ated Dat:
i [f) User-Defined Functions R nvarchar
LEE ] sDeleted bit
Accountld [ RIRRSRNERO DB L=
CreatedByld | K Name Datatype  *
CreatedDate @ d nvarchar
S AccountFromld nvarchar
Account Told nvarchar
COpportunityld nvarchar
Role nvarchar
< >
<
=
o]
| | | |\Save AFatch Log ,\Generate ,\Validate P\Debugger ,\Sesswon Log )\Noi'rficaticns f H £
Ready MUM
44.2 Connectto Informatica PowerCenter on Linux

You can set up and verify a connection between Informatica PowerCenter and Firebird

through an ODBC driver on Linux.

Prerequisites

e Configure the Informatica services.
¢ |nstall Devart ODBC Driver for Firebird. For instructions, see Installation.

e Configure a data source name (DSN). For instructions, see Linux DSN Configuration.

Connect to Firebird

1. Navigate to the directory where the ssgodbc.1linuxe4 utility is located.
cd /opt/informatica/tools/debugtools/ssgodbc/11inux64
2. Run the ssgodbc.1inuxe4 utility to verify the connection to Firebird.
./ssgodbc.1inux64 -d <your_dsn> -v

3. Run a SQL query to retrieve data.
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4.5

SELECT Id,Name FROM <table>;

~1% ed Jopt/informatica/tools/debugtools/ssgodbe/1linux64
Tinux64]1% ./ . Linuxé -V
/ssgodbc.linux64: /11b64/1ibodbc.so: version information available (required by ./ssgodbc.linux64)

Driver ODBC version = -03.51-

Enter SQL string: SELECT Id,Name FROM Account;
1d

Name
00 1KBBBOBOSRHMWY A4

Acme (Sample)
00 1KBOOOORERHMXY A4

Global Media (Sample)

Using in Microsoft Access

Connecting Microsoft Access to Firebird Using an ODBC
Driver

This article explains how to connect Microsoft Access to Firebird through the standard ODBC
interface. Microsoft Access is a dababase management system that combines the relational
database engine with a graphical user interface. Access can be used as a substitution for
spreadsheet applications like Excel to organize, store, and retrieve large amounts of related
data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your Firebird data either by importing it or creating a
table that links to the data. Devart ODBC drivers support all modern versions of Access. It is
assumed that you have already installed and configured a DSN for ODBC driver for Firebird.

For the purpose of this article, we tested an ODBC connection to Firebird through our ODBC
drivers in Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft

Access 2013, Microsoft Access 2016, Microsoft Access 2019. The following steps describe

how to use Microsoft Access 2019 to import or link to your data in Firebird.

Importing Firebird Data Into Microsoft Access Through an ODBC

Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
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9.

ODBC Dababase.

. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.

. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for Firebird and click OK.
. In the Import Objects dialog box, select the tables that you want to import, and click OK.

. If the database objects have been successfully imported, you should the see the

corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps

checkbox. Click Close.

The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Firebird Data in Microsoft Access Through an ODBC
Connection

1.
2.
3.

Open your Microsoft Access database.

Select the External Data tab in the ribbon.

Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

. In the Get External Data - ODBC Database dialog box, select Link to the data source

by creating a linked table.

. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for Firebird and click OK.

. In the Link Tables dialog box, select the table or tables that you want to link to, and click

OK.

. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields

that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the Firebird table as the unique record identifier. You are linking
multiple tables, you will be prompted to select unique record identifiers for each of the

selected tables.
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9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

46 Using in Microsoft Excel

Connecting to Firebird from Microsoft Excel using ODBC
Driver for Firebird

You can use Microsoft Excel to access data from a Firebird database using ODBC
connector. With ODBC Driver, you can import the data directly into an Excel Spreadsheet

and present it as a table. Make sure that you use matching Excel and ODBC Diriver, e.g. if
you have installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers.

e Connecting Excel to Firebird with Get & Transform (Power Query)

e Connecting Excel to Firebird with Data Connection Wizard (Legacy Wizard)

e Connecting Excel to Firebird with the Query Wizard

e Connecting Excel to Firebird with Microsoft Query

e Connecting Excel to Firebird with PowerPivot

Connecting Excel to Firebird with Get & Transform
(Power Query)

You can use Get & Transform (Power Query) to connect to Firebird from Excel with ODBC.
This method assumes that you've installed an ODBC driver for Firebird.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other
Sources > From ODBC.
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H Bookl - Excel Evgeniy Lemeshov [ O
File Home Insert Page Layout Formulas Review View Help & Tellme X Share
& [o |_ B  a [TA ~N [ Be B 5
]
B, g2 o Y:&. " B B =
B i - .
Get Refresh z| Sort Filter Text to G What-If Forecast Outline
Data ~ D All = Y cColumns =8 7 Ex Analysis =~  Sheet M
G Sort & Filter Data Tools Forecast ~
j From File L
c v
[y
From Database L - - - - " ' ' =
— 4 »
Fy m - ] + 100%
= am From Azure » From Table/Range
-]
_';jj From Online Services * _@ From Web
m —
_.¢. From Other Sources * | & From Microsoft Query
B
E Combine Queries 4 _.¢. From QDBEC

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the
connection string for your data source (without credentials, which are defined in the
credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.
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From ODBC

Data source name (DSN)

Devart ODBC Dniver b

4 Advanced options

Connection string (non-credential properties) (optional) G

501 statement [optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (opticnal)

(Mone) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.

ODBC driver
Default or Custom @ dsn=Devart ODBC Driver
. Use a username and password to access a data source with an QDBC driver,

Windows

User name
Database myusemame

Password

FEERRBERDEE

Credential connection string properties (optional) (O

Back Cancel
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If your database is not password-protected or you've already specified your credentials in the

ODBC data source settings, select Default or Custom and press Connect

Default or Custom

Windows

Database

QDBC driver

< dsn=Devart ODBC Driver

Don't specify any credentials or only connection string properties.

Credential connection string properties (optional) (D)

Back

Connect

Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.

Navigator

Select multiple items
Display Options =
EXECREG

=
2|
=
=
=22
ez
2|

FAC_VEM_DETALLE
FAC_VEN_DETALLEY
FILA_ENTREGA_AVI...
FIRST

FISH

FUNCAD

2

[2

N

FISH

ID CATEGORY
1| Triggerfish
2 Snapper
3| Wrasse
4 Angelfish
5| Cod
&|Scorpionfish
7| Butterflyfish
8| Shark
9| Ray

SPECIES_MNAME

Load

COMMON_NAME
null Clown Triggerfish
null Red Emperor
null| Giant Maori Wrasse
null Blue Angelfish
null| Lunartail Rockcod
null| Firefish
null| Ornate Butterflyfish
null| Swell Shark
null| Bat Ray

- Transform Data

[3

NOTES
Bin
Bin
Bin
Bin
Bin
Bin
Bin
Bin V)
Bin

Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further

work with it.
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H ©- BookZ - Excel Evgeniy Lemeshov

File Hom | Inser | Page | Form | Data | Revie | View | Help | Table Design | Query O‘ Tell me ,f:l'r Share

Al - F v
A B 5 D E|~

1

2 | 1 Triggerfish Clown Triggerfish

3 | 2 Snapper Red Emperor

4 | 3 Wrasse Giant Maori Wrasse

5 | 4 Angelfish Blue Angelfish

6 | 5 Cod Lunartail Rockcod

7 | 6 Scorpionfish Firefish

8 | 7 Butterflyfish Ornate Butterflyfish

9 | 8 Shark Swell Shark

10 | 9 Ray Bat Ray -

Sheet3 | Sheetl | ® 1 5

Connecting Excel to Firebird with Data Connection
Wizard (Legacy Wizard)
You can use this option to connect to OLE DB or ODBC external data source that has

already been defined.
1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.

2. In the opened dialog, select ODBC DSN and click Next to continue.

3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter
and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the
place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Firebird with the Query Wizard

You can use this option to create a simple query for retrieving data from Firebird to Excel via
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ODBC driver.

1.
2.

0 N O O

Open Excel, in the main menu, click the Data tab.

Click the From Other Sources dropdown menu, and then click From Microsoft Query.

. In the appeared dialog, you can choose the data source you want to connect to.

. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.

. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.
. Select Return Data To Microsoft Excel and click Finish.

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

. The required data is successfully imported to Excel.

Connecting Excel to Firebird with Microsoft Query

You can use this option to create a more complex query for retrieving Firebird data to Excel
via ODBC driver.

1.
2.
3.

Start Excel, click the Data tab.
In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC Firebird). Uncheck Use the Query Wizard to Create/Edit Queries
and click OK.

. Now you can select the tables you want to add to your query. When you finish, just click

the Add button.

. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to Firebird with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data

models. To load the required data, do the following:

1.

In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.
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4.7

. In the opened window, click From Other Sources.
. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

. In the Specify a Connection String window, click the Build button.

a A~ W N

. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,
using data source name - Devart ODBC Firebird), and then click Next.
6. Now you should choose how to import the data (either select a table from the list or write a
query to specify the data to be imported).
7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.

Using in Microsoft Visual Studio

Importing Firebird Data into Visual Studio Through an
ODBC Connection

A Visual Studio is a powerful tool containing features that allow editing, debugging, and
compilating the code and creating applications that can be connected to any databases
product and services on a local machine and network, and any type of cloud (private, public,
or hybrid). To connect Visual Studio to a data source such as Firebird, you can use an
appropriate ODBC driver.

This guide describes how to connect to Firebird and retrieve data importing them to Visual
Studio with an ODBC driver. It is assumed that you have already installed and configured a
DSN for ODBC driver for Firebird.

1. Run Visual Studio Desktop and click Tool and select Connect to Database.

2. In the Add connection dialog box, select the Microsoft ODBC Data Source as a data
source.

3. In the Data source specification point expand the Data Source Name (DSN) drop-down
list and select the previously configured DSN for Firebird. Alternatively, you can connect to
the database by entering the DSN in a Use connection string field. To check whether
your connection is successful, click Test connection. Click OK.

4. If your data source is password-protected, Visual Studio will prompt you for user

credentials. Type your Username and Password in the respective fields and click OK.
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4.8

5. In the Server Explorer you can see the database structure. Choose Tables, right-click the
table you want to view the data of and select Retrieve Data. You can also preview the

contents of the database objects by clicking on them.

Using in OpenOffice and LibreOffice

Connecting to Firebird from OpenOffice and LibreOffice
using ODBC Driver for Firebird

The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access Firebird data from Open Office Base or
LibreOffice Base — desktop database management systems. Note that the Windows version
of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for

Firebird, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.
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Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.

© 2025 Devart  Request Support ODBC Forum Provide Feedback



https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

126 ODBC Driver for Firebird

iZ| Untitled 1 - O penOffice Writer

File Edit Wiew |nsert Format Table Tools Window Help

EI Mew 3 E Text Document Ctri+mM & -
2 Open.. Ctrl+O | & Spreadsheet ol
Recent Documents 3 @ Presentation S
i i PR
(3, Wizards » | T€ Drawing
@ Database
(B Close
H save Ctrl+S @ HTML Document
B saveas. Ctrieshiftes | 2 XML Form Document
Save All E Master Document
Reload ] Formula
Versions... i Labels
[& Export... iz Business Cards
Export as PDF... £, Templates and Documents
Send 3 |

2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name
of your data source into the field, e.g. ODBC Driver for Firebird, or you can click

Browse, double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection
3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

128 ODBC Driver for Firebird

Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Firebird and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard *

Steps Decide how to proceed after saving the database

1.5elect datab . - - "
elect database Do you want the wizard to register the database in OpenOffice?

R LB LS ® Yes, register the database for me

3.5et up user authentication _
(O Mg, do not register the database

.ESEWE and proceed
After the database file has been saved, what do you want to do?

Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

Help << Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you
want to store it.
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£ save As >
= v P » This PC » Downloads * DB v O Search DB »

Organize - Mew folder 4=z o

B This PC ~ Mame Date modified Type
-J 3D Objects 2 New Database 05.06.2019 16:43  OpenDocumetr
B Deskiop
|j_: Documents
4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

[+] Automatic file name Cancel
 Hide Folders extension

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-
click the table name.
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i New Databases.odb - OpenOffice Base — O X
Ele Edit View [nsert Tools Window Help X

B-B-E B8 E-0)lBeHe |

[E Create Table in Design View... ‘ Description

ﬁ

Use Wizard to Create Table...
[® create view..

—
(l=1]
=
m
o}

g

Gueris

SECOMND " None -
SECONDTABLE
SEG_ACSSMODULD
SEG_MODULOS
SEG_USU
SIMPLE_CHAR_TYPES

ﬁ

'|'|
[=]
=
W

Iz
m

-
o
3
s

9 SALE - New Databases2 - OpenOffice Base: Table Data View — O =
Eile Edit View |Insert Tools Window Help

BRI Xm® 0 WS- NBIRT v FY

ROW D SALE_DATE TERMINAL ID GROSS_AMT VAT AMT NET_AMT
2 24,12,15 3 11,10 22,20 33,30
5 24,1215 3 11,10 22,20 33,30
7 24,12,15 3 11,10 22,20 33,30
8 24.12.15 3 11,10 22,20 33,30
9 24,12,15 3 11,10 22,20 33,30
10 24.12.15 3 11,10 22,20 33,30
1 24,12,15 3 11,10 22,20 33,30
12 24.12.15 3 11,10 22,20 33,30
13 24,12,15 3 11,10 22,20 33,30
14 24,12,15 3 11,10 22,20 33,30
15 24,12,15 3 11,10 22,20 33,30
16 24,12,15 3 11,10 22,20 33,30
17 24.12.15 3 11,10 22,20 33,30

7. To create an SQL query, click Queries in the Database pane, then click Create Queryin

SQL View...
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MNew Database.odb - OpenOffice Base

File Edit Wiew Insert Tools

B-@-0

-

Window Help

ER Rt

ﬁ

Tables

[ Create Query in Design View...
lﬂ Use Wizard to Create Query...

|§Eu. Create Query in SQL View... |

Description
Create a query entering an SOL statement dire

e

ﬁ

Farms

Enter your query in the query text box and click Run Query (F5). The date will be fetched

i

from the database and displayed in Open Office or LibreOffice, respectively.

£ New Databases.odb : Query1 - OpenOffice Base: Query Design

File Edit Wiew [nsert Tools Window Help

A== B D Wiy

== WS- NHIRT vI¥|

ROW _ID | SALE_DATE | TERMINALID | GROSS_AMT VAT AMT MET_AMT

B |2 24,1215 3 11,10 22,20 33,30
5 241215 3 11,10 22,20 33,30
7 24.12.15 3 11,10 22,20 33,30
k] 24,1215 3 11,10 22,20 33,30
9 241215 3 11,10 22,20 33,30
10 241215 3 11,10 22,20 33,30
1 24,1215 3 11,10 22,20 33,30
12 24,1215 3 11,10 22,20 33,30
13 241215 3 11,10 22,20 33,30
14 24,1215 3 11,10 22,20 33,30

Record [1 [ of 35 HENDEE

SELECT *# FROM SALE:;

4.9 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
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an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
standalone.

Configure the Initialization File

After installing the gateway and the ODBC driver for Firebird, create an initialization file for

your Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initFirebird.ora. YOou need a separate initialization file for each ODBC data source. After
creating the file, set the Hs_Fps_conNNeEcT_INFO parameter to the system DSN that you created
earlier, for example:

HS_FDS_CONNECT_INFO=Firebird

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orRACLE_HOME\NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = localhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_NamE) must be the same in 1istener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.

SID_LIST_LISTENER=
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(SID_LIST=
(SID_DESC=
(SID_NAME=Firebird)
(ORACLE_HOME=D: \ORACLE_HOME)
(PROGRAM=dg4odbc)

)

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The s1p must match the value specified in the

listener.ora file.

Firebird =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = localhost) (PORT = 1521))
(CONNECT_DATA =
(SID = Firebird)

)
(HS = 0K)

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like

SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the

CREATE DATABASE LINK statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also
Configuring Oracle Database Gateway for ODBC

Using in PHP

Connecting to Firebird from PHP using ODBC Driver for
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Firebird

PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing Firebird via ODBC. The script connects to
Firebird database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$oDBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for Firebird}
Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($0ODBCConnection, $SQLQuery);

Step 3: Print the result set

The odbc_fetch_row[) function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.
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$result = odbc_result_all($Recordset, "border=1");
odbc_close($0DBCConnection);

7>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.

411 Using in Power Bl

Importing Firebird Data into Power Bl Through an ODBC
Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as Firebird, you can use a corresponding
ODBC driver.

This tutorial explores how to connect to Firebird and import data into Power Bl Desktop using

an ODBC driver. It is assumed that you have already installed and configured a DSN for

ODBC driver for Firebird.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for Firebird

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user
credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
of the database objects by clicking on them.

7. To load the Firebird data into Power Bl for analysis, select the needed table and click Load.
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412 Using in Python

Installing the ODBC Diriver for Firebird

One of the most convenient methods to connect to an external database or access cloud
data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to
work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download
the appropriate installer and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for Firebird. To use the ODBC driver as

a translation layer between the application and the database, you need to configure it by
following the installation instructions.

Connecting to Firebird from Python using ODBC Driver
for Firebird

Here’s an example to show you how to connect to Firebird via Devart ODBC Driver in Python.

First we import the pyodbc module, then create a connection to the database, insert a new
row and read the contents of the EMP table while printing each row to the Python interactive
console. To execute the script, you can type the code directly in the interactive console or add
the code to a file with the .py extension and run the file from the command prompt.

Step 1: Connect

import pyodbc _ _ _
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Firebird};Server=myser

Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the
database. The script inserts a new record to the EMP table.

cursor = cnxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535, 'Scott

Step 3: Execute query

The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
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print() function prints out all records from the table to the console.

cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:

print (row)

row = cursor.fetchone()
cursor.close()
cnxn.close()

Using in QlikView

Connecting to Firebird from QlikView using ODBC Driver
for Firebird

This tutorial describes how to connect and configure QlikView to retrieve data from Firebird
for further analysis. QlikView is a data visualization tool that connects and pulls data from
different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres, etc. to
present it in a single view. The business intelligence platform identifies relationships in your
data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data
sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or
later.

To connect to an ODBC data source from QlikView using our driver for Firebird, perform the
steps below:

1. Open the QlikView client application and click File > New. Close the Getting Started
wizard and open File > Edit Script (CTRL+E).
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@ qlikview x64 Personal Edition - [av1]

{ File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help

i | New ctri+N || B | | v | (2| @) 52 B K clear | @ Back @ Forward | & Lock & Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Open URL...
Open FTP...
Close
Favorites 4
=l | save Ctrl+5
Save As.. F12

Save Link

Mail as Attachment...

1]
i]

are. as a LInk

vid viL (=100 4
2 P Ctr|+P
Print Sheet...
Source Control »
Export 4
| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select
the Data Source you created earlier, type in the User ID and Password if your database is
password-protected. You can test the connection by choosing Test Connection. The
Connection Test succeeded message should appear. Click OK to connect to your data

source.
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Q

File Edit Insert Tab

Tools  Help

-l Reload #Debug | [ S| & -2 @] O [0 <1 2 Tabs Main

v |22 =

3 e

[GET

Data  Functions ‘arables Settings

[ atabaze
| apec ~ Connect...
[ Forze 32 Bit Select...

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

[1ata from Files —1

[ Relative Paths
[JUzeFTR

@ Connect to Data Source

User ID Pazswond
|m_l,.lid | |ooooo| |

Data Sources

i}
Devart ODEC Drriver for ASE
Drewart ODBC Driveer for Firebird
Devart ODBC Driver for Interbase
Devart ODBLC Driver for bMagento
Devart ODBC Diiver for MailChimp
Diewart ODBC Diriver for MySEIL
Devart ODEC Driver for MetSuite
Dewart ODBC Driver for Oracle
Drewart ODBC Drriver for SOL Azure
Devart ODBC Driver far SOLite
Mesweart CNRC Ciniver for vRacs

[ Show User DSMs

Test Connection...

*

Canecel

Help

0K Cancel

will be suggested to choose fields to be displayed.

Q@ Edit Script [C\Users\Evgeniyl\Documentsynew.qvw®]

Help

File Edit Insert Tab Tools Help
Sl Reload B Debug | [ S| 4 -2 B 2O L3 41 2 Tabs Main x| 25 =
[GET]
ODBC CONNECT TO [Devart ODBC Driver for Firebird]:
SELECT * FROM SALE;|
Data  Functions  Warishles  Settings
Database D ata from Files
| ODBC - BeEsk. [ Relative Paths Table Files...
Uz FTR i Ei
[ Foree 32 Bit Select... BISSE=m Fl=-.
“Web Files...
Field Data...
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Sheet Properties [Main]

General Fields  Objects  Securty Triggers
Awvailable Fields
GROSS_AMT

SALE_DATE
TERMINAL_ID
VAT_AMT

Add =

Add Al ==

< Remove

*
Fields Displayed in Listboxes
NET_AMT

ROW_ID

4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

and fields. You can retrieve date from multiple tables and fields by selecting them and

clicking Add. When you are ready with your SELECT statement, click OK. You will get

back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.
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@ Create Select Statement = O *
Data source Devart QDBC Driver for Firebird Caonnect..
Database Diriveer...
Cwer Support...

[atabase Tables Fieldz | Text Order - |
[ Show al REF_GABARITO A ~
Tables REFP_TEXTOS GROSS_AMT
2] Views REP_TEXTOS_HIST NET_AMT
ROW_ID
W|essarsme SECOND SALE_DATE v
[ System Tables SECOMDTAELE O ——
[ &liases CER ACSCRNMI N ¥ | [ Show Icon for Key Fields
Script  Table Columns  Preview Elobs
SOL SELECT * (®) Colurnn
FROM SALE; () Row
() Shuctured
[] Preceding Load
Add

5. Once the data has been fetched, you can choose a table layout to present the data in a
table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to
the tablebox and click OK.

) QlikView x64 Personal Edition - [CUsersh ODBC\ Documentsh 1.gvw™]

HRN=RoN" =N RE N,

File

Edit

View  Selections

Layout | Settings Bookmarks Reports  Tools  Object  Window  Help

| Add Sheet...

id

Main

2
sl

[ I R o R

b ok ok ok ok ek ek
TR b L [ O D

ik

i Promote Sheet
vl Demote Sheet

Remove Sheet

'7g Kl Clear ~ | (& Back (2 Forward | (5 |

Select Fields...
|| | MNew Sheet Object v || [B] List Box...
74 Rearrange Sheet Objects =| Statistics Box...
#Y| Adjust Off-Screen Objects E|l Multi Box...
Align/Distribute v [ Table Box..
all Chart..
E] Input Bozx...
\E] Current Selections Box..,
lil Button...
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@ clikview x64 Personal Edition - [C\Users\EvgeniyL\Documents\new.qvw*] = O *®
i File Edit WView Selections Layout Settings Bookmarks Reports Tools  Object  Window  Help -0
RN H S E 9 o O & |zl v | @ k? B K clear ~| @ Eack @ Forward | 5 Lock =" Unlock
Main Sheet
= (.

GROSS_AMT NET_AMT ROW_ID SALE_DATE TERMINAL_ID VAT _AMT

11,10 33,30 2 24.12,.2015 3 22,20

11,10 33,30 5 24.12,.2015 3 22,20

11,10 33,30 7 24.12.2015 3 22,20

11,10 33,30 8 24.12.2015 3 22,20

11,10 33,30 9 24.12.2015 3 22,20

11,10 33,30 10 24.12,.2015 3 22,20

11,10 33,30 11 24.12.2015 3 22,20

11,10 33,30 12 24.12.2015 3 22,20

11,10 33,30 13 24.12.2015 3 22,20

11,10 33,30 14 24.12,.2015 3 22,20

11,10 33,30 15 24.12,.2015 3 22,20

11,10 33,30 16 24.12.2015 3 22,20

11,10 33,30 17 24.12.2015 3 22,20

11,10 33,30 18 24.12,.2015 3 22,20

11,10 33,30 15 24.12,.2015 3 22,20

11,10 33,30 20 24.12.2015 3 22,20

414 Usingin SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Firebird from SQL
Server Management Studio using ODBC Driver for Firebird.

e Creating a Linked Server

e Troubleshooting in SSMS

4141 Creating a Linked Server

Requirements

In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN.

e The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysW OW64\odbcad32.exe.

e ODBC Diriver for Firebird and SQL Server must be installed on the same computer.
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e NET Framework 4.5 must be installed on the computer.

Connecting to Firebird from SQL Server Management
Studio using ODBC Diriver for Firebird

You can use the Microsoft SQL Server Management Studio to connect your Firebird data to
an SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as Firebird
and merge them with your SQL Server database. You can create a linked server with one of
these methods: by using the options in the Object Explorer or by executing stored
procedures.

Below are major advantages of using SQL Server Linked Servers to connect to Firebird:
1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the
organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to Firebird

You can follow the steps to create a linked server for Firebird in SQL Server Management
Studio by using Object Explorer:

1. Start your Management Studio and choose your SQL Server instance.
2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers

and then click on New Linked Server.

3. Configure your linked server in the dialog box:
¢ Give a name for your server in the Linked server field.
e Under Server type, select Other data source .

e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down
list.

¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for
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Firebird. Alternatively, you can input the ODBC Driver connection string in the Provider

field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access Firebird databases through SQL Server.

Retrieving Data From Firebird

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on
it

Object Explorer = 1 x
Connect~ ¥ ¥ ¢

=] E EVGEMIYLANSOLEXPRESS (5QL Server 14.0.1000 - C
Databases
Security
= Server Objects
Backup Devices
= Linked Servers
= Providers
@8 ADsDSOObject
@f MSDAOSP
Wi MSDASOL
wE MSOLAP
@8 MSOLEDBSQL
w8 Search.CollatorDS0O

In the appeared Provider Options window, enable the Allow inprocess checkbox:
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@E Provider Options - Microsoft OLE DB Provider for ODBC Drivers

Selecta page IT Script ~ &) Help
F General

Provider options:

Enable Name
Dynamic parameter
MNested queries
Level zero only
Allow inprocess
Maon transacted updates
Index as access path

Disallow adhoc access

Supports Like' operator

Limlemd mmmamen samimn thin meossid e

Create a new Linked Server

Object Explorer * I x
Connect~ ¥ ¥ ¢ o+
= @ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
:
Providers |_ Mew Linked Server...
Triggers

Start Powershell

Replication
PolyBase Reports '
Management Refresh

HEvent Profiler

3]

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:
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H New Linked Server = O *
Selecta page HSGI‘iDtVﬂHeIp
# General
& Security
& Server Options b
Server type:
() 5QL Server

(®) Other data source

Pravider: Microsaft OLE DB Provider far ODBC Drivers w

Product name:

Data source:

Location

| |
| |
Provider string: | |
| |
| |

Catalog

Connechon

Now you need to input the Linked Server name, e.g. FIREBIRD. In the Product Name and
Data Source fields you need to indicate the System DSN that you've previously created -
more info on System DSN setup can be found here.

A New Linked Server = O *
Select a page HSC:‘iDi'@HeIp
» General
& Securty
# Server Options e FIREBIRD
Server type:
(") 50L Server

(®) Other data source

Provider: Microsoft OLE DB Provider for QDBC Drivers w

Product name: |Devart ODBC Driver for Firebird |
Data source: |F|rebird |
Provider string: | |
Location | |
Catalog | |

Connechon

The Firebird tables are already available to be fetched. To query the linked server, click New

Query in the toolbar:
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File Edit View Project SQOL Complete Tools  Windoy
i0-0|8®-1-2 | B New Query B 5 &
: | | P Execute

———————————————————————————
Object Explorer = 0 x

Connect~ ¥ *¥ (VIS

=] E EVGEMIYLASQOLEXPRESS (5QL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
.
Providers
H ORACLE
B POSTGRESGL
B sauTe

B EHEBH

Enter your SQL query in the editor window and click Execute to run the query:

ng SQLQuery6.sql - EVGENIYL\SQLEXPRESS.master (sa (54))* - Microsoft SQL Server Management St... Cuick Launch (Cirl+0) P = B x
File Edit View Query Project SQL Complete Tools Window Help

fe-o B -t BN BNewauey BRS8NI H| Q-0 - H| 5 -l e
| master | b et © vE2E[E] R BlED| = e Ex 0,
Object Explorer MR Il SOLQueryb.sgl - E..S.master (sa (534))* ® X -
Connect= % ¥ & —|SELECT * FROM [FIREBIRD]...[SALE]; =+
Y
= @ EVGENIVL\SQLEXPRESS (SQL Server 14,0.100( A Bl
Databases
Security
= Server Objects
A 100 % -
Backup Devices
=] Linked Servers BH Resuts B Messages
Praviders ROW_ID SALE_DATE TERMINALID GROSS_AMT VAT_AMT NET_AMT ~
B AMAZON REDSHIFT 1 20151224 3 11.10 2220 3330
B st 2 20151224 3 11.10 2220 3330
B BIGCOMMERCE 1 20151224 3 11.10 2220 3330
5 S 4 20151224 3 11.10 2220 3330
5 20151224 3 11.10 2220 3330
= B FIREBIRD [ 20151224 3 11.10 2220 3330
= M Catalogs 70 51224 3 11.10 2220 1330
System Catalogs g 12 20151224 3 11.10 220 330
= @ default 3 13 20151224 3 11.10 220 330
Tables 014 20151224 3 11.10 2220 2330
Views 1115 20151224 3 11.10 2220 3330
8 FRESHBOOKS 12 16 20151224 3 11.10 220 3330
B INTERBASE V) |ELEREE] osiEansa o 1140 5590 anan 2
< > @ Query execut.. | EVGENIYL\SQLEXPRESS (14.0 RTM) | sa (54) | master | 00:00:08 | 35 rows

As a result, you can see the contents of the selected table retrieved directly from the Firebird
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account you are connected to.

See also
¢ Troubleshooting SSMS

4.14.2 Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its

properties:

TR

-
. Component Services

%. File Action VWiew Window Help
e rEIXEC BB LIE

DEO”S"lERO"t Windo...  Windows... Windows R... Windows R... “ | Actions
4 #: Component Services

} DCOM Config -
4 || Computers ﬁ ﬁ ﬁ ﬁ
More Actions »

4 (& My Computer i . i .
N i Microsoft Microsoft Microsoft Microsoft

b ] COM+ Applicatiol| oo Windows.. WMIPro.. WMIProvi..
[ [ DCOM Config

> (-] Running Processe ﬁ ﬁ ﬁ ﬁ

[ [ | Distributed Trans;
i [3] Event Viewer (Local) Microsoft... Microsoft.L.. MicrosoftV.. Microsoft.

ApplD
ML A MSMDPP - MsRdpSess..
Applicati.. LIZE

MSTTS Mahimic5e.. MAP Agent Map Elevated
DecObj Cla.. Service COM class

g 4 & @

NCLUA MDFAPL netman netprofm

$ & & @

MetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...
< I 3 -

b 4% Services (Local)

m

e e T e ] T P —T T
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4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:

F B
MSDAINITIALIZE Properties L2 S|

| General I Location | Security | Endpoints I Iderrt'rt'_.rl

Launch and Activation Pemissions
(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

Corfiguration Pemissions
7 Use Default

i@ Customize

Leam more about setting these properdies.

[ OK ][ Cancel ] Apply

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions
available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are
connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:
1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-
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11D1-89E0-00C04FD7A829}

3. Right Click>Permissions>Advanced>Owner Tab:

-

. _ .
| Advanced Security Settings for {2206CDB0-19C1-11D1-89E0-00C04FDTA20) S0

gt

Pemissions I Auditing | Owner | Effective Pemissions

You can take or assion ownership of this object f you have the required permissions or privileges.

Cument owner:

o e - - gy -

Change ownerto:

Name

[ Cther users or groups...

[7] Replace owner on subcontainers and objects

o 2R e L o P P A O N AL £
e

Leam about object ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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-

.
| Permissions for (2206CDB0-10C1-11D1-89E0-00COAF... ()

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

oK ]| Cancel Apply

After this you should be able to edit MSDAINITIALIZE security settings.

See also
e Error message when you try to create an instance of an OLE DB provider in SQL Server:

"Cannot create an instance of OLE DB provider"

415 Usingin SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for Firebird as a

translation layer between the data source and SSIS, the driver and SSIS communicate via
Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,
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an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues
to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the
Advanced Settings tab and select ver 2.x from the obBc Behavior dropdown.

General Advanced settings  License About

Meta Data
Connection
-—
Compatibility
ODBC Behavior | Ver 2.x ||
String Types Default &

IUse Local Regional Settings when converting to string

[ Imumbers [ ]Dates and times

Test Connection - Cancel

416 Usingin Tableau

This section describes how to establish and troubleshoot a connection to Firebird from
Tableau using ODBC Driver for Firebird.

e Using in Tableau

e Troubleshooting in Tableau on macOS

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

156

ODBC Driver for Firebird

4161

4.16.2

Using in Tableau

Importing Firebird Data Into Tableau Through an ODBC
Connection

This article explains to establish and ODBC connection to Firebird from Tableau Desktop.
Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,
and create meaningful reports to get actionable insights. With Tableau Desktop and our suite
of ODBC drivers, you can connect to various relational and non-relational databases, both
cloud and on-premise.

1. Run Tableau Desktop.

2. On the start page, select More... in the Connect pane.

3. Choose Other Databases (ODBC).

4. Expand the DSN drop-down list and select the DSN that you have created and configured
for Firebird. Alternatively, if you have not created a DSN, you can choose the Driver option
and select Devart ODBC Driver for Firebird from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in Firebird.

. You should see the list of all tables you have access to in the connected data source.

© 00 N O O

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the
table.

10.Hit Update Now to retrieve and display the data.

Troubleshooting in Tableau on macOS

Troubleshooting ODBC Connection in Tableau on
macOS

The iODBC driver manager incorrectly handles the SQL_WCHAR and SQL_WVARCHAR
ODBC data types. To work with these data types in Tableau, create a Tableau Datasource
Customization (. tdc) file in 'Users\[your name]\Documents\My Tableau Repository
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\Datasources\' — for example, devart-firebird.tdc, and add the following capabilities to the file:

<?xml version='1.0"' encoding='utf-8' 7>
<connection-customization class='genericodbc' enabled='true' version="1.0"'>
<vendor name='Firebird' />
<driver name='Devart ODBC Driver for Firebird' />
<customizations>
<customization name='CAP_ODBC_BIND_SUPPRESS_WIDE_CHAR' value='yes'
</customizations>
</connection-customization>
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